Contents

Quick Start .................................................. 1
Welcome ..................................................... 9
  What is Corel AfterShot Pro? .......................... 9
  What’s new in Corel AfterShot Pro 3? ................. 14
  Workspace tour ........................................... 16
  Understanding non-destructive editing .................. 18
  Understanding the Library ............................... 22
  Understanding the export process ...................... 24
  System requirements ..................................... 26
  Supported cameras and file formats .................... 27
  About image size .......................................... 28

Learning how to use Corel AfterShot Pro ............... 31
  Using the Help system ................................... 31
  Corel AfterShot Pro User Guide PDF .................... 32
  Learning with video tutorials ........................... 32
  Using Web-based resources .............................. 32

Library and catalogs ........................................ 35
  About the Library ........................................ 35
  About catalogs ............................................ 36
  Importing images ......................................... 37
  Managing your Library .................................... 39
  Portable catalogs ........................................ 43

File System mode ........................................... 45
  Image settings in File System mode .................... 45

Editing photos .............................................. 47
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About non-destructive editing</td>
<td>48</td>
</tr>
<tr>
<td>About adjustment tools</td>
<td>49</td>
</tr>
<tr>
<td>Standard tools</td>
<td>52</td>
</tr>
<tr>
<td>Histogram</td>
<td>52</td>
</tr>
<tr>
<td>Basic Adjustments</td>
<td>53</td>
</tr>
<tr>
<td>Presets</td>
<td>57</td>
</tr>
<tr>
<td>Color tools</td>
<td>57</td>
</tr>
<tr>
<td>Tone tools</td>
<td>63</td>
</tr>
<tr>
<td>Detail tools</td>
<td>65</td>
</tr>
<tr>
<td>Metadata tools</td>
<td>71</td>
</tr>
<tr>
<td>Plugins</td>
<td>73</td>
</tr>
<tr>
<td>Selective editing</td>
<td>77</td>
</tr>
<tr>
<td>Retouching with Heal, Clone, or Blemish Remover</td>
<td>84</td>
</tr>
<tr>
<td>Removing red eye</td>
<td>88</td>
</tr>
<tr>
<td>Cropping</td>
<td>88</td>
</tr>
<tr>
<td>Straightening</td>
<td>89</td>
</tr>
<tr>
<td>Working with Presets</td>
<td>90</td>
</tr>
<tr>
<td>Copying and pasting settings</td>
<td>93</td>
</tr>
<tr>
<td>Undoing changes</td>
<td>95</td>
</tr>
<tr>
<td>About default settings</td>
<td>96</td>
</tr>
<tr>
<td>Using the History palette</td>
<td>97</td>
</tr>
<tr>
<td>Editing photos in an external image editor</td>
<td>98</td>
</tr>
<tr>
<td>Corel AfterShot HDR</td>
<td>101</td>
</tr>
<tr>
<td>Working with Corel AfterShot HDR</td>
<td>101</td>
</tr>
<tr>
<td>Organizing images</td>
<td>103</td>
</tr>
<tr>
<td>Versions</td>
<td>103</td>
</tr>
<tr>
<td>Stacks</td>
<td>105</td>
</tr>
<tr>
<td>Thumbnail indicators</td>
<td>108</td>
</tr>
<tr>
<td>Sorting</td>
<td>109</td>
</tr>
<tr>
<td>Filtering</td>
<td>110</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Labels</td>
<td>111</td>
</tr>
<tr>
<td>Ratings</td>
<td>113</td>
</tr>
<tr>
<td>Flags</td>
<td>113</td>
</tr>
<tr>
<td><strong>Keywords</strong></td>
<td>115</td>
</tr>
<tr>
<td>Effective use of keywords</td>
<td>115</td>
</tr>
<tr>
<td>Working with keywords and keyword sets</td>
<td>117</td>
</tr>
<tr>
<td><strong>Metadata</strong></td>
<td>123</td>
</tr>
<tr>
<td>Types of metadata</td>
<td>123</td>
</tr>
<tr>
<td>Storing and sharing metadata</td>
<td>124</td>
</tr>
<tr>
<td>Working with metadata</td>
<td>125</td>
</tr>
<tr>
<td>Viewing metadata</td>
<td>125</td>
</tr>
<tr>
<td>Editing metadata</td>
<td>126</td>
</tr>
<tr>
<td>Managing metadata sets</td>
<td>126</td>
</tr>
<tr>
<td>Finding photos by using metadata</td>
<td>128</td>
</tr>
<tr>
<td>Metadata in images that you output</td>
<td>130</td>
</tr>
<tr>
<td>Adding metadata in other applications</td>
<td>131</td>
</tr>
<tr>
<td><strong>Watermarks</strong></td>
<td>133</td>
</tr>
<tr>
<td>Watermark settings</td>
<td>134</td>
</tr>
<tr>
<td>Saving watermarks as presets</td>
<td>137</td>
</tr>
<tr>
<td><strong>Exporting images</strong></td>
<td>139</td>
</tr>
<tr>
<td>About exporting</td>
<td>139</td>
</tr>
<tr>
<td>Exporting without a batch preset</td>
<td>140</td>
</tr>
<tr>
<td>Exporting with a batch preset</td>
<td>142</td>
</tr>
<tr>
<td>Using batches with folders</td>
<td>143</td>
</tr>
<tr>
<td>Pausing, resuming, and stopping batches</td>
<td>143</td>
</tr>
<tr>
<td>Managing batches</td>
<td>144</td>
</tr>
<tr>
<td>Understanding export settings</td>
<td>146</td>
</tr>
<tr>
<td>Web Galleries</td>
<td>151</td>
</tr>
<tr>
<td>Copying images</td>
<td>155</td>
</tr>
</tbody>
</table>
Adjusting the workspace ........................................... 159
  Showing and hiding panels ................................... 160
  Viewing options .................................................. 161
  Multi-Image View ................................................. 161
  Resizing panels .................................................. 162
  Magnifier ........................................................... 163
  Metadata viewer ................................................... 164

Slideshows ............................................................ 165
  About slideshows .................................................. 165
  Slideshow settings ............................................... 166
  Playing a slideshow .............................................. 167

Printing ............................................................... 169
  Printing with Corel AfterShot Pro. ............................ 169
  Printing a folder of images ..................................... 171
  Print settings ...................................................... 171
  Controlling print jobs and page breaks ...................... 172
  Managing print batches ........................................ 174
  Print layouts ..................................................... 175

Application preferences ........................................... 181
  Accessing preferences ......................................... 182
  General preferences ............................................ 182
  Display preferences ............................................. 183
  Color Management preferences. .............................. 185
  Import and Cache preferences ............................... 185
  Renaming preferences ......................................... 186
  Sequence preferences .......................................... 187
  Keyboard preferences .......................................... 187
  Soft Proofing preferences .................................... 188
  Copy Sets preferences .......................................... 188
Defaults preferences ........................................ 189
Crop preferences ............................................. 189
External Editor preferences ............................... 190
Performance preferences ................................ 190
Hardware Acceleration preferences ................... 190

Additional information ....................................... 193
Renaming formats .......................................... 193
Metadata tags ................................................ 204
File locations .................................................. 206
Command line options ...................................... 208
Custom print layouts ....................................... 209
About color management .................................. 211
Terminology ..................................................... 214

Updating and extending the application ............... 219
Finding and installing downloadable content .......... 219
Providing feedback for downloadable content ...... 220
Restoring purchases ....................................... 220
Quick Start

This section introduces some of the basic tasks that you can accomplish in Corel AfterShot Pro. If you're looking for a quick way to start working with the application, take a few minutes to go through the steps below. The steps include handy shortcuts and tips that help you work quickly.

There are three main steps:

1. Open your photos in Corel AfterShot Pro.
2. Select and edit one or more photos.
3. Output your edited photos individually or as a batch.

Before you begin, see “Workspace tour” on page 16 for a quick overview of the workspace.

Step one: Open your photos

To get you started quickly, we're going to work directly from the folders on your computer. After you're familiar with the application, you can choose to build a Library by importing photos into Corel AfterShot Pro. When you're ready for more information, see “About the Library” on page 35.

To navigate to your photos

- In Corel AfterShot Pro, click the File System tab, and navigate to your folder in the Directory View.
When you click a folder, the photos from the folder are displayed as thumbnails in the Thumbnail panel.

![Thumbnail panel, displayed as a strip in Standard View](image)

**Step two: Selecting and editing photos**

To view and adjust images, you need to select them. The Thumbnail panel displays thumbnails of the photos that are in the active folder. When you select a thumbnail, the Preview panel displays a larger view of the photo. When you edit a photo, the original file (master file) is never altered — edit information is saved separately and what you see onscreen is a master version, a preview that shows your edits. You can edit the entire photo or a selected area of the photo. When you are finished editing a photo, you can simply move on to the next photo, or you can save your changes as a new version. This means that you capture the edits as a variation of the original file. The version can be viewed as a thumbnail or in the Preview panel. It can also be output.
To preview and select photos

1. In the Browse panel, click the File System tab.

2. Navigate to the folder you want. The Thumbnail panel displays the photos that are in the folder.

3. Click a thumbnail to display it in the Preview panel.

Before you start editing, you can choose between viewing the edits directly on the master version of your file, or creating a new version for editing by pressing Insert or by right-clicking the thumbnail and choosing Version > New Version from Defaults.

You can also

<table>
<thead>
<tr>
<th>Action</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll quickly through thumbnails</td>
<td>Press [ or ].</td>
</tr>
<tr>
<td>Compare two or more photos (or versions) in the Preview panel</td>
<td>Click the <strong>Toggle Multi-Image View</strong> button (or press M), and Ctrl + click or Command-click the thumbnails. The Preview panel displays the selected photos. This is a great way to select and flag the best photo in a series of similar photos. For more information about flagging and organizing your photos, see “Organizing images” on page 103.</td>
</tr>
<tr>
<td>Select all thumbnails</td>
<td>Press Ctrl + A or Command-A.</td>
</tr>
<tr>
<td>Deselect thumbnails</td>
<td>Click a background area of the Thumbnail panel or press Ctrl + D or Command-D.</td>
</tr>
</tbody>
</table>

**Note:** The last image you select is called the active image. While in Multi-Image View mode, metadata changes, adjustments, and other edits apply only to the active image.
To edit a photo

1. In the Browse panel, navigate to the folder you want. The Thumbnail panel displays the photos that are in the folder.

2. Click a thumbnail to display it in the Preview panel.

3. Experiment by trying any of the editing actions in the following table.

<table>
<thead>
<tr>
<th>To</th>
<th>Do the following</th>
</tr>
</thead>
</table>
| Flag or add keywords (i.e. add metadata) | • Flag — click a thumbnail and on the Top toolbar click the Flag as Pick button \( \text{Flag as Pick} \) or press \( . \) (period key). To mark a photo as a reject, click the Flag as Reject button \( \text{Flag as Reject} \) or press \( , \) (comma key).  
• Keywords — on the Tools panel, click the Metadata tab, click inside the Keywords box, and type one or more keywords, separated by commas. |
| Crop a photo | On the AfterShot Pro toolbar at the bottom of the Preview panel, click the Crop tool \( \text{Crop} \). In the Cropping palette, adjust the settings that you want, and in the Preview panel, drag the crop area over the area that you want to preserve. Click Done in the Cropping palette. |
| Adjust the color, tone, or sharpness of the entire photo | In the Tools panel, click the Standard tab, and adjust the settings you want in the Basic Adjustments section. |
To Edit a selected area only

1. Click the **Open Layer Manager** button in the upper-right corner of the window.
2. In the **Layers** palette, click the **+Adjust** button at the top of the palette. A new editing layer is created.
3. Click a **Region** tool, such as the **Circle Region** tool, click an area that you want to adjust, and adjust the **Size**, **Feather**, or other settings at the bottom of the **Layers** palette.
4. In the **Basic Adjustments** section of the Tools panel, adjust any of the settings you want — the changes apply to the selected area(s) of the current layer.

**Tip:** There are some handy ways to undo actions. Here are a few you can try:

- To undo one action at a time, press **Ctrl + Z** or **Command-Z**.
- To reset a Tools panel slider to its original setting, double-click the slider name.
- To clear all the changes that you've made to a photo, right-click the thumbnail, and choose **Settings > Apply Default Settings** from the context menu.

**To show your edits on a new version**

- In the Thumbnail panel, right-click or **Control-click** an edited photo (master version), and from the context menu, choose **Version > New Version from Current**.

**Note:** You can confirm that a photo has been edited by looking for the **Edit** icon in the corner of the thumbnail.
A new thumbnail appears next to the thumbnail of the master version. By default, versions use the following naming convention: original file name + version number (v2, v3, ...).

Three edited versions based on the same master file

You can now return to the master version and edit it in a new way and create another version. To start from the original settings, you can clear the edits made to the master version by right-clicking or Control-clicking the thumbnail, and choosing Settings > Apply Default Settings from the context menu.

Tip: Whether you choose to create a new version before or after editing a master version depends on your workflow. For example, if you know that you want to make several versions from the outset, you can create a version before you start editing, so you can always see how the original master file looks. If you want to quickly fix a photo, you can simply edit the master version—you can create other versions later if you want. The non-destructive nature of editing in Corel AfterShot Pro gives you maximum flexibility.

For more information about editing photos, see “Editing photos” on page 47.

Step three: Exporting photos for sharing and print

After you organize and edit your photos, you can share your work by exporting your photos. Exporting lets you save your photos to a standard file format so that you can share your work on the Web, via email, or use your files in other applications. You can also output your
Quick Start 7

files to print. There are a number of standard output choices, called batches, that let you output quickly, but you can also create a custom batch. For example, you can choose file type, quality, color space, and image size. You can also set a naming convention to rename the files when they are output and you can apply presets. For more information about outputting, see Exporting images.

To get you started quickly, let's use standard batches to save to JPEG and print a couple of 5 x 7 inch photos.

**To output to a full-sized JPEG**

1. In the Thumbnail panel, select one or more photos that you want to output.

2. Do one of the following:
   - In the Browse panel, click the **Output** tab, and in the **Batch Output** section, drag the thumbnails to **JPEG Full Size**.
   - Press F (shortcut key assigned to **JPEG Full Size** batch).

3. In the **Select a Destination** dialog box, choose a folder where the files will be saved.
After you select a destination folder, files are saved automatically to that folder for the rest of the session. You can change the destination and access other output settings by double-clicking a batch name in the **Batch Output** or **Printing** section.

**To print to a standard print size**

1. In the Thumbnail panel, select two photos that you want to print.
2. In the Browse panel, click the **Output** tab, and in the **Printing** section, drag the thumbnails to a batch name, such as **5x7 Qty.2**. Numbers appear next to the batch name, **(0 of 2)**, to indicate the number of photos printed and the total number of photos in the batch.
3. Double-click the batch name to preview the print job in the **Print Settings** dialog box.
4. In the **Print Layout** section, enable the **Scale crop** or **Scale reduce** option (matches the photos to the selected print ratio) and preview the results.
5. Choose your printer from the drop-down list in the bottom left corner.
6. Click **Print**.

**Moving on**

Now that you have been introduced to the basics, here are some additional topics that will provide you with more detailed information:

- About the Library
- Managing your Library
- Editing photos
- Organizing images
- Exporting images
Welcome

In this section, you’ll learn about

- What is Corel AfterShot Pro?
- What’s new in Corel AfterShot Pro 3?
- Workspace tour
- Understanding non-destructive editing
- Understanding the Library
- Understanding the export process
- System requirements
- Supported cameras and file formats
- About image size

What is Corel AfterShot Pro?

Corel AfterShot Pro is a fast, flexible workflow application for digital photos, including RAW formats, JPEG, and TIFF. Corel AfterShot Pro is designed to help you organize, optimize, and output your photos. You can work with individual photos or tap into powerful and flexible multi-image processing options that let you adjust and output your photos so you can print them or share them via email or the Web. Corel AfterShot Pro is completely non-destructive; your original image files are always safe. You can use Corel AfterShot Pro on its own, or with your favorite image editing software.

For a full list of learning resources, from the menu bar choose Help > Learning Center.
How is Corel AfterShot Pro different from other image-editing software?

There are a few things that set Corel AfterShot Pro apart from traditional image-editing software. Let's take a look at these differences.

<table>
<thead>
<tr>
<th>Action</th>
<th>Traditional image-editor</th>
<th>Corel AfterShot Pro</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open files that you want to edit</td>
<td>File &gt; Open File, open one or more files.</td>
<td>As a workflow application, you tend to work with folders, so click the File System tab, and click a folder. You can then right-click to import the folder to the Library or click a thumbnail and start editing.</td>
</tr>
<tr>
<td>Edit files</td>
<td>Start editing each open file, when finished, the editing information is saved to the file.</td>
<td>Start editing, creating one or more looks (versions) for each photo. The edits are saved automatically to a sidecar file (XMP) so that your original file is never affected. You can really experiment, even between editing sessions.</td>
</tr>
</tbody>
</table>
Photo workflow refers to all the activities that occur between the initial image capture and the final photo output. Photographers have very different workflows, depending on the volume of photos they take and what they do with the photos. Your workflow might be as simple as downloading images from your camera’s memory card and printing them on a printer that is attached to your computer. A photo workflow might also include any of the following:

- Organizational tasks, such as adding keywords and star ratings so you can search and sort your images
- Editing and adjusting photos to correct, enhance, or creatively manipulate photos
- Backing up and archiving photos
- Sharing photos through email or on the Web

<table>
<thead>
<tr>
<th>Action</th>
<th>Traditional image-editor</th>
<th>Corel AfterShot Pro</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the files</td>
<td><strong>File &gt; Save</strong>, usually for each file that you want to output, save to the file format you want (such as JPEG). You either overwrite your existing file, or create a new file.</td>
<td>Select as many thumbnails (photos or looks) as you want, and to export to a standard JPEG, press F. Want TIFF? Press T. New files are created, your original file is never affected. *Corel AfterShot Pro lets you export multiple files at one time, and offers a range of settings that let you customize your output. Choose File &gt; Export or right-click any of the batch presets in the Batch Output section of the Output tab to access the settings.</td>
</tr>
</tbody>
</table>
• Printing photos in-house, through online printing services, service bureaus, or prepress facilities

Corel AfterShot Pro supports a wide range of workflow options and working styles to ensure that you can get the best quality from your photos in the least amount of time.

![Photo workflow: 1. Transfer photos from your camera to your computer, 2. Import the photos into Corel AfterShot Pro, 3. Edit your photos, creating one or more versions, 4. Export a version to a JPEG or TIFF file.]

Corel AfterShot Pro is organized into three workflow areas: Asset management, Image editing, and Output generation.

**Asset management** lets you catalog your original digital photos as master files and view, add, browse and search photo metadata. As your photo library grows from hundreds to thousands of photos, maintaining a coherent, organized, searchable library becomes critical. Corel AfterShot Pro provides all the tools needed to catalog your current photographs, and makes it easy to add to your library.
**Image editing** lets you adjust and correct elements such as exposure, white balance, detail, and distortions. You can get creative with a variety of editing features that you can apply to an entire photo or a selected area. For example, you can use selective editing to select one color area in your photo and apply a color to that area without affecting the rest of the photo.

**Output generation** lets you share the photos that you have worked on in Corel AfterShot Pro. Your photos can be output in a wide range of formats that you can print, email, or share on the Web. The powerful Batch Conversion feature lets you take advantage of multi-image processing.
What’s new in Corel AfterShot Pro 3?

New! Comprehensive Watermarking

Protect and promote your work with versatile and quick-to-apply new Watermarking features. Deter unauthorized copying, brand your photos with your logo or contact info, or add any text and graphics. Apply watermarks to individual photos or batches, and easily adjust size, rotation, position, transparency and more. For more information, see “Watermarks” on page 133.

Enhanced! Highlight Recovery

Regain more of the detail and tone from your overexposed photos with enhanced Highlight Recovery in AfterShot Pro 3. Powered by a new algorithm, this feature lets you access more of the data in your RAW files for superior image quality. A Highlight Recovery Range slider gives you finer control over specific areas to adjust within your image. For more information, see “Tone tools” on page 63.

New! Blemish Remover

Save time and edit faster by doing more touchups and photo corrections in AfterShot Pro 3, rather than jumping to Corel PaintShop Pro or Adobe PhotoShop. The new Blemish Remover offers circle, brush, polygon and freehand tools for detailed editing, making portrait editing faster and easier than ever. Remove dust, spots, smudges and a variety of imperfections on any photo. For more information, see “Retouching with Heal, Clone, or Blemish Remover” on page 84.

New! Image Preset Library

Now it’s easier to tap into the power of presets to automate more of your repetitive processing jobs or quickly reproduce a look that would otherwise be tedious to replicate. The new Image Preset Library in
AfterShot Pro 3 lets you browse, preview and download free and for-purchase presets. For more information, see “Finding and installing downloadable content” on page 219.

New! Lens Corrections

Update to Corel AfterShot Pro 3 for new, sought-after lens corrections that build on the hundreds of lenses already supported by Corel AfterShot to quickly correct the different types of distortion introduced by various lenses. Join the AfterShot Pro community on Facebook to discover when new lens corrections are posted or to share your own. For more information, see “Lens Correction” on page 67.

Enhanced! See what’s new with Plugins

The new Plugin Manager lets you find and install plugins in a flash from within AfterShot Pro 3. Extend your software with free plugins from the community, purchase plugins and get updates. Want to try making your own plugins? Our unique plugin API and toolkit let you make pro-quality plugins that tap into the full power of the AfterShot Pro processing pipeline. A love of photography, a knowledge of C++ and the updated Plugin SDK are all you need. Share your plugins freely with the AfterShot community, or work with Corel to sell them. Want to learn more? Contact Corel via the Feedback Helper. For more information, see “Updating and extending the application” on page 219.

New! Camera profiles

Corel constantly delivers support for today's most popular, powerful and creative cameras, including professional DSLRs, flexible and high-quality mirrorless cameras, and many more. A new dynamic camera profile updater notifies you when new cameras are added and a new feedback mechanism captures and prioritizes your requests with Corel.
For more information, see “Updating and extending the application” on page 219.

Get involved!

Corel has built AfterShot Pro to give you, the photographer, control, letting you make your own plugins, lens corrections and presets. Similarly, a new feedback loop makes it easier for you to send your ideas and requests to the Corel Photo team—better helping us to meet your needs. Simply click ‘feedback’ and send us your comments. “Providing feedback for downloadable content” on page 220.

Workspace tour

The Corel AfterShot Pro workspace includes the following elements:
1. **Menu bar**

The menu bar is used to access common functions and features. For example, you can import folders, set your preferences, or access the Help.

2. **Top toolbar**

This toolbar contains a variety of search, metadata, layer, and viewing commands.

3. **Preview panel**

The Preview panel lets you view a large version of the photo that is selected in the Thumbnail panel. When Multi-Image View is enabled, the Preview panel displays previews of all the selected thumbnails. You can view image adjustments and zoom into or out of the selected images.

4. **Tools panel**

Like the Browse panel, the Tools panel has tabs for pages that contain a number of sections. For example, the **Standard** page displays the **Histogram**, **Basic Adjustments**, and **Presets** sections. Sections can be pinned so they stay visible.

The Tools panel can be hidden so that more room is available for viewing your images. Just click the arrow at the top of the Tools panel tabs to hide or show this panel.

Included in the Tools panel is the **Get More** page. It is home to a collection of downloadable content that includes camera profile updates, plugins, and image presets. For more information, see

5. **Status bar**

The Status bar lets you view information about the current image and access viewing controls such as Toggle Multi-Image View and Lock.
Position and Zoom. Soft-proofing and Clipping Warning controls are also accessible here.

6. Thumb Zoom toolbar

This toolbar contains the Thumbnail Size control which lets you adjust the size of the thumbnails in the Thumbnail panel.

7. Thumbnail panel

At the bottom of the main Corel AfterShot Pro window, this panel shows thumbnails for the folder, container, search or browse category selected with the Browse panel. All the images in the folder are initially visible in the Thumbnail panel, but you can filter the images to show only the thumbnails that match a specific set of criteria.

8. AfterShot Pro toolbar

This toolbar contains editing tools and viewing options for the Preview panel.

9. Browse panel

The Browse panel is your main access point for your photos. The panel has tabs for the Library, File System, and Output pages. Some pages are further divided into sections. For example, the Library page consists of a Catalogs section and a Metadata Browser section. The Browse panel can be hidden so that more room is available for viewing your images. Just click the left arrow at the top of the Browse panel tabs to hide or show the panel.

There are many ways to adjust and customize the Corel AfterShot Pro workspace. “Adjusting the workspace” on page 159.

Understanding non-destructive editing

Corel AfterShot Pro is a non-destructive image editor, meaning that adjustments you make to your images in Corel AfterShot Pro will never
alter the data in the original image. You are free to experiment as much as you want, knowing that you can always revert to the original version. As a non-destructive image editor, the adjustments you create are stored either in a sidecar XMP file, within the Corel AfterShot Pro catalog database, or both. This means that when you're ready to share or export your work, you need to output the versions you want to a standard file format.

All your edits are saved in a sidecar file (XMP)

When you edit a photo in Corel AfterShot Pro, a new version is created that contains the adjustments you've made. Corel AfterShot Pro allows more than one set of image adjustments to be made on a single photo, allowing you to efficiently make many versions of a single image. Creating a new version does not make a copy of the original master file, but rather just allows you to apply different image adjustments and metadata to the same Master file.
Corel AfterShot Pro stores its settings in an XMP file that is slightly different from other popular image editors and photo management applications. We do this to prevent Corel AfterShot Pro from overwriting settings created by other applications and to circumvent limitations inherent in the current XMP standard (such as only being able to export the metadata from one version at a time, or the inability to save different settings for a RAW file and a JPEG that were created in camera as a RAW+JPEG pair).

Corel AfterShot Pro uses a similar, but slightly different filename to store this enhanced XMP data. The XMP filename is created by simply adding ".xmp" to the end of the complete filename of the image file it describes (while many other applications build the XMP filename by first dropping the image file extension (like "jpg", "nef" or "cr2") before adding "xmp"). So a Corel AfterShot Pro XMP file would look like

---

Master version from original (left) and edited versions (center). The changes are committed only when you output to JPEG or TIFF.
img_0000.jpg.xmp while an XMP from other applications for the same image would simply be img_0000.xmp.

Corel AfterShot Pro lets you create a standard XMP file that other applications will read, but this limits the settings to those officially supported by the XMP standard (one set of metadata per image file).

**Shared XMP data**

Other applications store image adjustments in sidecar XMP files, and metadata added in other applications can be imported into Corel AfterShot Pro. These include:

- Star ratings
- Color labels
- Flags (called 'Picks' or 'Selects' in other applications)
- Keywords and categories
- IPTC and EXIF data

Likewise, applying any of these settings to images in Corel AfterShot Pro will write this data back to the XMP file for those images. Many applications allow you sync settings from XMP files with the settings they hold in their internal databases. After the sync process is complete, adjustments made in Corel AfterShot Pro appear in those applications as well.

For more information, see “Organizing images” on page 103.

**XMP data exclusive to Corel AfterShot Pro**

Settings from image editing tools within Corel AfterShot Pro and other applications are also stored within XMP files; however, these settings are not shared amongst applications from different manufacturers. This is due to the technical differences in implementing various image adjustment tools. These differences in how the various tools are implemented give each application its own image quality.
characteristics, and prohibit image adjustment settings from being shared between applications.

Using Corel AfterShot Pro in no way limits what you can do with your images or which applications you can use to edit or manage your digital photographic files.

**How metadata is processed when you import files**

Corel AfterShot Pro reads and collects metadata embedded in image files, in Corel AfterShot Pro XMP files and standard XMP files. The process and order of collecting metadata from these various sources is shown below.

1. If a Corel AfterShot Pro XMP file exists, metadata is read from this file and no other metadata is imported.

2. If no Corel AfterShot Pro XMP file is found, metadata is read from Standard XMP files.

3. If XMP content is embedded in the image file, this is read next and is added to any previously found XMP data, but common fields found in any other source are ignored.

**Understanding the Library**

Your Library is where you store one or more catalogs of photos. It is a key part of the asset management system. It lets you access the master files (original photos) as well as all the versions that you create. You can read photo metadata, and search and browse for photos based on the associated metadata.

Review the information in this section, and when you're ready to start importing, see Importing images.
The Corel AfterShot Pro Library and catalogs

If you choose to use Corel AfterShot Pro's asset management features, you will start by importing images into a catalog. This catalog is where data and metadata for your photos will be stored. The Library consists of one or more catalogs, which store data such as:

- Links to original master files (path information and file information)
- Metadata for image searching and browsing
- Image adjustment settings, and a complete editing history
- Previews and thumbnails
- Catalog-specific settings

Asset management is optional

Although importing your photos to the Library is recommended, it is not required. You can still view and edit photos and use the RAW file conversion features without adding files to your Library. How? You simply click the File System tab and navigate to the photos in the Directory View.

When would I not want to import photos?

Here are some examples of cases where you may choose not to import photos:

- If you simply want to see what photos are on a memory card or other storage device. For example, if you want to grab a few RAW files from your friend's memory card, you can use the File System tab to find and view the photos. You can then copy only the photos that you want to your computer and import those photos.
- If you already have an asset management application and don't want to replace it. For example, perhaps you have third-party software that copies and builds an image folder structure.
• If you have many photos that you need to import and you simply want to get started quickly.

Features available after importing photos to the Library

After you import your photos to a catalog in your Library, you have full access to the following features:

• **Browsing multiple folders** — select multiple folders and view all the thumbnails in the folders and subfolders in one flat view.

• **Full editing history** — an editing log is maintained for every change that you make to photos and versions over time. If you do not import your photos, the edit log is maintained only for the current session (the log is cleared when you exit the application).

• **Image search** — find images by searching for filename, EXIF, IPTC or other metadata.

• **Metadata browsing** — browse through your catalog using EXIF, IPTC or other metadata.

• **Image stacks** — group versions from one or many master files together into stacks.

• **Offline image browsing** — find and manage images that are stored on offline media like CDs, DVDs or external hard drives.

• **Initial image settings** — Corel AfterShot Pro stores the first set of adjustments found for every image when you import. This lets you quickly revert to these settings at any time. The **Initial Settings** might be the same as the **Default Settings**, or they might be different because they include any edits or adjustments made in Corel AfterShot Pro before importing.

Understanding the export process

Exporting takes the previews that you see in Corel AfterShot Pro and creates new image files that you can print, share on the web, or use in other applications. Since Corel AfterShot Pro is a non-destructive
image editor, the image adjustments and optimizations you create in Corel AfterShot Pro are only accessible to other applications when exported to standard file formats, such as JPEG and TIFF.

A batch lets you export one or more images and lets you customize the output. For example, you can rename the files as they are processed and change the file type. There are two main types of batch operations:

- **File Output batches** — convert versions to a new image file that can be accessed by any other application.
- **Copy Output batches** — lets you copy the master files. This option lets you copy or move files from one location to another. You can also perform many of the same actions as you can with File Output batches.

For more information about exporting, see “Exporting images” on page 139.

**File Output batches**

Corel AfterShot Pro comes with several batch output presets to convert the versions you create to standard file formats. You can customize any of these batches.

Examples of batch output presets:

- **JPEG Full Size**: JPEG Image type, 90% image quality. Same Pixel Dimensions as the master file.
  Converts to sRGB colorspace. Ideal for printing and general output.
- **JPEG Proof**: JPEG Image type, 80% image quality. Half Height, Half Width of the master file.
  Converts to sRGB colorspace, ideal for sharing on the Web.
- **16-bit TIFF**: TIFF Image type, with 16 bits-per-pixel color data. Same Pixel Dimensions as the master file.
Ideal when exporting images for editing in other applications (must support 16-bit images)

- 8-bit TIFF: TIFF Image type, with 8 bits-per-pixel color data. Same Pixel Dimensions as the master file.

  Ideal for exporting images so you can use them in other applications that do not support 16-bit images

**Copy Output batches**

A Copy batch does just that — it copies the master versions added to the batch to a predefined location or locations, optionally renaming the destination files. A Copy batch will copy all sidecar files that accompany the images added to the batch, ensuring that XMP and other sidecar files are kept together with the original files.

Copy batches are great for automating backups and for downloading images from camera memory cards.

**System requirements**

*Corel AfterShot Pro 3 is 64-bit

**Windows**

- Windows 10, Windows 8.1, Windows 8, Windows 7 with latest service pack (64-bit editions)
- 64-bit Intel or AMD processor (multi-core processor recommended)
- 2 GB of RAM (4 GB recommended for HDR)
- 400 MB of available hard-disk space required
- 1024x768 resolution with 16-bit color display (1280 x 768 resolution with 24 bit or higher color display recommended)
- Internet connection required for online help and program updates
Macintosh
- Mac OS X 10.9 or later (64-bit edition)
- All Intel Macs model are supported
- 2 GB of RAM
- 250 MB of available hard-disk space required
- 1024 x 768 resolution with 16-bit color display
- Internet connection required for online help and program updates

Linux
- Fedora 19 or Ubuntu 14.04 or later (64-bit distributions)
- 64-bit Intel or AMD processor (multi-core processor recommended)
- 2 GB of RAM
- 250 MB of available hard disk space required
- 1024 x 768 resolution with 16-bit color
- Internet connection required for online help and program updates
- Dependencies: Glib 2.4, KDE or GNOME recommended (full list of dependencies in RPM & DEB packages)
- Enable desktop compositing and freedesktop.org-compliant window manager (KDE, Gnome, and others) recommended
- 64-bit distributions require 32-bit compatibility libraries (ia32-libs)

Supported cameras and file formats
RAW files from a wide array of digital cameras are supported as well as JPEG and TIFF files. Examples of RAW formats include 3FR, ARW, CR2, CRW, DCR, DNG, ERF, K25, KDC, MEF, MOS, NEF, NRW, ORF, PEF, RAF, RW2, SR2, SRF, X3F.

For a the latest list of supported cameras, visit www.aftershotpro.com.
About image size

In film photography, understanding the size of an image was simple — it was simply the size of the print. With digital photography, things are a little more complicated. There are at least three different aspects to the size of a digital photograph:

- **File Size** — typically measured in megabytes (MB), this measures to the amount of disk or memory card space consumed by the image file.
- **Pixel Size** — measured in pixels or megapixels, this is measures the number of individual pixels or colored dots that comprise the image.
- **Print Size** — measured inches, millimeters, or other physical units of measure. Any time a measure of length, like inches or centimeters, is used to describe a digital image, they are referring to Print Size.

Every digital photograph from a given camera will start out with the exact same **Pixel Size**, which will be something like 6000x4000 pixels, or about 24 megapixels and corresponds to the number of photo sites or pixels your camera's sensor has. However, the **File Size** for different photos from the same camera will vary. This is based on image content and is due to compression techniques used to make the file as small as possible. Generally speaking, a higher megapixel camera will produce larger files.

**Print size** is determined by two things: **Pixel Size** and how many pixels to print in a given physical size, commonly called DPI or dots per inch or PPI, pixels per inch. For example, the 6000x4000 pixel image from the example above, when printed at 300 DPI will be approximately 20 inches by 13.3 inches (6000 pixels / 300 pixels per inch = 20 inches). Changing only the DPI in no way affects the file size on the photo or
the pixel size, it only changes the Print Size. For example, changing that same image to 600 DPI, which would yield a 10 inch by 6.6 inch print.

DPI and Print Size only matter when printing an photo; DPI is irrelevant to images on screen, in email, or otherwise viewed, edited or used on a computer. Pixel Size alone determines how much information or "quality" in stored in the image file.

**Cropping and resizing**

Cropping an image is used to recompose the shot to include only portions of the original image, or to change the Aspect Ratio — the height relative to the width — of the photo. If you have several images from the same camera that you want to print the same size, some after cropping and some without cropping, then the DPI of those images must be different.

Resizing allows you to make the Pixel Size larger or smaller than the original image. To continue the example from above, suppose you cropped a portion of the image from the center of the frame, say 1500 by 1200 pixels. A "Full Size" output image from this cropped image would be 1500 by 1200 pixels — much smaller than your original image. You could print this image at 10 inches by 8 inches — but that would be at 150 DPI (passable, but lower print quality). If you wanted to make an image in Corel AfterShot Pro that had the same pixel dimensions as the original file, you would need to upscale — or stretch the image. Upscaling does not add information or quality to the photo, it is not generally recommended because it will not print significantly better results than before the image was upscaled.

**Note:** For more information about cropping, see “Cropping” on page 88.
When DPI or Print Size matters

If you print from within Corel AfterShot Pro, then DPI and Print Size will be handled for you automatically by our Print Output system. If your images are only shown on computer screens, in email or in other electronic forms, then DPI and Print Size are meaningless.

DPI and Print Size only matter when you output images from Corel AfterShot Pro to be printed by someone else.
Learning how to use Corel AfterShot Pro

You can learn how to use AfterShot Pro in various ways: by accessing the Help or user guide PDF, by exploring videos, or by engaging with the Corel AfterShot Pro community.

This section presents the following topics:

- Using the Help system
- Corel AfterShot Pro User Guide PDF
- Learning with video tutorials
- Using Web-based resources

Using the Help system

The Help that is available from within the program is the most comprehensive source of information for Corel PaintShop Pro. The Help system provides two ways to find information. You can choose a topic from the Contents page, or use the Search page to search for specific words and phrases. You can also print topics from the Help.

To use the Help system

1. Do one of the following:
   - Click Help ➤ Help topics.
   - Press F1.

2. In the Help window, click one of the following tabs:
   - Contents — lets you browse through topics in the Help
   - Search — lets you search the full text of the Help for a particular word or phrase (no quotation marks required). For example,
you are looking for information about a specific tool or command, you can type the name of the tool or command, such as **Backlighting**, to display a list of relevant topics.

**Corel AfterShot Pro User Guide PDF**

You can download the Corel AfterShot Pro User Guide PDF to your computer or tablet, or you can print the pages you want. You can find the PDF on the Learning page.

**Learning with video tutorials**

The **Corel Discovery Center** (English only) lets you find and view a range of videos that help you learn about the application and photography.

You can also find video links within some topics in the online Help and by visiting www.youtube.com/corel aftershotpro.

**Using Web-based resources**

You can access a number of Web pages dedicated to customer support and communities. You can find resources such as downloads, tutorials, tips, newsletters, newsgroups, and other online resources. For a full list of Web-based learning resources, see Learning page for Corel AfterShot Pro.
Here are a few resources to get you started:

- **Corel Support** — this link takes you to the Customer Support Web page
- AfterShot Community forum
- Facebook page for Corel AfterShot Pro
Library and catalogs

Your Library is where you store one or more catalogs of photos. It is a key part of the asset management system. A catalog is a collection of photos and their associated image data. In essence, a catalog is a database that can be managed within Corel AfterShot Pro.

In this section, you’ll learn about

- About the Library
- About catalogs
- Importing images
- Managing your Library
- Portable catalogs

About the Library

Your Library is where you store one or more catalogs of photos. It is a key part of the asset management system. It lets you access the master files (original photos) as well as all the versions that you create.

A catalog is a collection of photos and their associated image data. In essence, a catalog is a database that can be managed within Corel AfterShot Pro. Catalogs contain master files, thumbnails and preview images, image settings, image adjustments, and catalog-specific preferences.

The Library can be accessed from the Browse panel. The Library page contains the Catalogs section which lists all the folders and photos that
you have cataloged by importing. For more information about importing to the Library, see “Importing images” on page 37.

About catalogs

When images are first imported into a Corel AfterShot Pro catalog, the initial settings used for that image are taken from a Corel AfterShot Pro XMP file if one exists. If no Corel AfterShot Pro XMP file is found, metadata settings (keywords, rating, labels, IPTC or XMP tags) are read from standard XMP files, or the image file itself.

Catalog versus XMP

After images have been imported into a Corel AfterShot Pro catalog, changes to any image or metadata settings are stored within the Corel AfterShot Pro catalog. The changes can be written back to the AfterShot Pro XMP files manually by selecting the thumbnails for the images you want, right-clicking one of the thumbnails, and selecting
XMP > Write AfterShot XMP files. Alternately, you may choose to have Corel AfterShot Pro always keep the XMP files up to date. You can do so in the General preferences by enabling the Allow automatic AfterShot .xmp creation for photos in Catalogs check box.

Multiple catalogs

Most people can easily work with one catalog. All photos are imported to the default catalog, and you can easily search and filter to find the photos you want in the catalog. However, if you take photos for different reasons, professional versus personal for example, you can create separate catalogs. Corel AfterShot Pro lets you build, open, and work with many catalogs from your Library simultaneously. This allows you to group, backup, and manage sets of files as catalogs, while preserving the ability to browse, search, and access any image in any open catalog. For more information about creating catalogs, see “Managing catalogs” on page 42.

Importing images

When you import images into Corel AfterShot Pro, they are added to a catalog. You can choose to import an entire folder, a folder and all the subfolders it contains, or you can selectively import one or more files within a folder.

Importing is a process that you control. If you add a new folder or subfolder to your computer, you must import the new folders if you want to add them to your Library. If you have added several subfolders or individual images to an existing folder structure, you can reimport from the root folder to ensure that you catch all the new items — duplicate catalog entries are not created if you import a photo from the same source location more than once.
To import a folder

1. Do one of the following
   - Click **File > Import Photos from Folder**. In the dialog box, navigate to the folder you want and click the **Select Folder** button.
   - In the Browse panel, click the **File System** tab, and in the **Directory View**, right-click the folder you want, and choose **Import Folder** from the context menu.

2. In the **Import Photos** dialog box, confirm that the **Source Folder** button displays the name of your folder.
   To include subfolders, enable the **Include images from subfolders** check box.

3. Confirm that the **Import into Catalog** button displays the name of the catalog you want to use. If you want to create a new catalog, click the button.

4. (Optional) Enable the **Apply Import Settings** check box and enter any keywords that you want to apply to all the photos within the folder. You can also apply presets in the same way.

5. Click **Begin Import**.

   **Note:** All the photos in the folder are cataloged. To check your catalog, click the **Library** tab, and navigate to your folders in the **Catalogs** section. Note that the files are not copied when they are cataloged — they are referenced from their original location.

   **Tip:** If you don't want to import all the photos in a folder, you can open the folder, and in the Thumbnail panel, select the thumbnails for the photos that you want to import. Click **File > Import Selected Files**, and choose the import settings you want in the **Import Photos** dialog box.
Managing your Library

Your Library consists of catalogs and the files and versions that each catalog contains. You can move, copy, rename, and delete one or more files or versions at a time to get organized. You can also manage your Library by creating more than one catalog, and control which catalogs are accessible by opening or closing catalogs.

For more information about versions, see “Versions” on page 103.

Moving and copying versions

You can move or copy versions to a new location.

   Note: When you move or copy a version, the master file and all related versions are copied or moved.

To move or copy versions

• Do one of the following:
  • To move a version, drag the thumbnail from the Thumbnail panel to the folder of your choice in the Browse panel.
  • To copy a version, hold Ctrl or Command while dragging the thumbnail from the Thumbnail panel to the folder of your choice in the Browse panel.

Renaming versions

You can choose to rename your versions by using renaming formats if you want to rename several versions at one time with a consistent format.
The **Rename Versions** dialog box has the following controls and features:

- **Format** — choose from a list of existing formats.
- **New Name** — lets you enter a renaming format. For example, if you use [jobname] or [jobseq] in the **New Name** box, you can enter a job name in the **Job Name**. The sequence [jobseq] format remembers the last number used in any previous renaming for this job name, and will continue numbering where it left off.
- **Next [rseq]** — if you include [rseq] in the **New Name** box, that text will be replaced with a unique, incrementing sequence number that will start over the next time you rename versions. This control allows you to set the number.
- **Reset [jobseq]** — restart the numbering for the job name sequence selected.
- **Rename all Versions derived from Master Versions** — enable this check box to number the master versions sequentially and any related versions with the same name (adds "_v1", "_v2" etc to each version). If you do not check this option, each version is given a unique name.
For more information about how to use renaming formats, see “Renaming formats” on page 193.

**To rename one or more versions**

1. Select the thumbnails for the versions that you want to rename.
2. Press F2 or right-click and select **Version > Rename Version**.
3. Edit the **New Name** field, using text or renaming formats like [date]. Or, select an existing renaming format from the **Format** drop-down list.

   The Preview updates as you edit the **New Name** field to show you the results of the renaming format.

**Deleting versions**

You can delete a master version (which represents the original photo, or master file) at any time, but different things happen when you delete a master version versus other types of versions.

- **Deleting a master version**: When you delete a master version, all associated versions are also deleted. The original master files are moved to your computer's Recycle Bin. Review any messages that appear to confirm the action.
- **Deleting non-master versions**: When you delete versions which are not master versions, there is no impact to the original master file — the version thumbnail and associated data is removed from the sidecar XMP file.

  **Note**: When Multi-Image View is enabled, only the single active version is removed, not the entire selection.

**To delete a master file or version**

- Select the thumbnails of the master versions that you want to delete and do one of the following:
  - Press **Delete**.
• Right-click a thumbnail and choose Version > Remove Version. If you have selected a master version, a message appears to warn you that the original file for the master version will be moved to the Recycle Bin.

Managing catalogs

You can create one or more catalogs in your Library. Although you may choose to use one catalog for simplicity, using multiple catalogs lets you create logical groups so you can search, browse, edit, store, and backup specific groups of images at a time without needing to access or open the rest of your Library.

You can create a new catalog at any time. You can open or close catalogs. When you close a catalog, it does not display in the Library. To access the Library, click the Library tab on the Browse panel.

To create a new catalog

1 Right-click inside the Catalogs section of the Library, and select Catalog > New Catalog, or click File > New Catalog from the menu.

2 In the Create and Choose New Catalog Folder dialog box, choose an empty folder or create a folder.

3 Click Select Folder.

The new catalog appears in the Catalogs section.

To open an existing catalog

• Right-click inside the Catalogs section of the Library, and select Catalog > Open Catalog, or choose File > Open Catalog from the menu.
To close a catalog

• In the Catalogs section of the Library, right-click the catalog that you want to close, and choose Catalog > Close Catalog.

**Portable catalogs**

Individual catalogs for Corel AfterShot Pro can be used in only one session at a time, but they can be accessed from a fast (local) network from multiple Corel AfterShot Pro applications. If the master files are accessed by two machines differently (mapped as different network drives on Windows, or mounted differently on Linux or Mac) then you'll need to edit the Catalog Preferences to select the proper root folder. For example, assume that you access master files stored on a local hard drive D: on your main desktop computer and store the AfterShot Catalog on that drive also, but have a second computer that accesses the same catalog and master files from the main desktop computer. On this second machine, the D: drive is mapped as X:. If you imported images into a Corel AfterShot Pro catalog on the main desktop computer and then opened that same catalog on the second computer, Corel AfterShot Pro would look for those master files on the second computer's D: drive instead of on X:.

To solve this, you can create movable catalog paths inside the catalog that is shared by the two machines, and set the location of the movable catalog path differently to account for the different ways these two machines access the same catalogs and master files.

**To create a moveable path**

1. On the main computer, click the Library tab and right-click the catalog into which you have imported files from a shared location (if your catalog is open, you'll see a letter that represents the network drive your catalog is mapped to).

2. In the context menu, click Set Movable Paths.
3 In the **Set Moveable Catalog Paths** dialog box, click **Add**.

4 In the **Select a Local Directory** dialog box, choose the drive that holds the imported images that you want to share across the network. Try to stay as close to the root of the directory as possible.

5 Click **Select Folder** to set this drive as a moveable catalog path. This does not affect how Corel AfterShot Pro accesses master files on this first machine, but it prepares the catalog for updating on the second machine. Click the **Add Note** button to capture path information related to where the folder is stored on the drive that you selected.

6 Close Corel AfterShot Pro on the first machine. Now you can copy your catalog to another computer.

7 Map the catalog drive of the main computer as a network drive.

8 On the second computer, open Corel AfterShot Pro.

9 Click **File > Open Catalog**, and import your catalog.

10 In the **Library**, right-click the catalog and choose **Set Moveable Paths** from the context menu.

11 Click **Set**, and navigate to the drive where the cataloged files are referenced.

12 Click **Select Folder**, verify the paths in the **Set Moveable Paths** dialog box, and click **OK**.

**Note:** it is not necessary to set a movable catalog path before importing images, nor before opening the catalog on a second computer as long as you remember the original file locations.
File System mode

File System mode lets you access and edit uncataloged photos. It is a quick way to access any supported image file on your computer, without needing to import images into a catalog. It's a good way to access photos that you may not keep, but when you don't import photos, you'll miss out on some features that are only possible when working on images in a Corel AfterShot Pro catalog. If you start working with photos in File System mode, you have the option of importing the photos to a Library catalog later.

For more information about File System mode, see “Understanding the Library” on page 22.

In this section, you’ll learn about
• Image settings in File System mode

Image settings in File System mode

Since the File System mode does not maintain a persistent catalog, the image adjustment and metadata settings are written to a Corel AfterShot Pro XMP file after each adjustment. Each time you browse to a new folder, Corel AfterShot Pro will scan the folder, removing any files from Corel AfterShot Pro that have been deleted from your computer, adding any new images found, and refreshing the settings for all existing files with the latest settings found in the XMP files. This ensures that what you see in Corel AfterShot Pro in File System Mode matches exactly what is saved on your computer. This also means that
the edit history (as seen in the History palette) is reset between each session.

**Note:** If you're editing in File System mode and Library mode, it can cause issues — edits to photos may not be visible if you edit the same file in both File System mode and Library mode (the information is written to the file in a different way). Therefore, it is recommended that after you import a file into a Library catalog, you always access the file from the Library.
Editing photos

Editing photos in AfterShot Pro can be as quick and simple or as detailed and precise as you like. All your editing is completely non-destructive, so you can experiment with confidence.

In this section, you’ll learn about

• About non-destructive editing
• About adjustment tools
• Standard tools
• Histogram
• Basic Adjustments
• Presets
• Color tools
• Tone tools
• Detail tools
• Metadata tools
• Plugins
• Selective editing
• Retouching with Heal, Clone, or Blemish Remover
• Removing red eye
• Cropping
• Straightening
• Working with Presets
• Copying and pasting settings
• Undoing changes
About non-destructive editing

The image editor in Corel AfterShot Pro is completely non-destructive, so you are free to experiment and edit your images as much as you want, knowing that you can always revert to the original version. All the edits that you make and metadata that you add is stored either in a sidecar XMP file, within a Corel AfterShot Pro catalog, or both.

To view or use your image adjustments in other applications, you need to export the image. For more information about exporting your files, see Exporting images.

The original file is always protected. The master version is based on the original file, but you can create as many versions as you like.

Because your original file is always protected (as a master file), when you edit a photo, your edits are viewable within Corel AfterShot Pro on a representation of the master file called a master version. You can
create as many additional versions as you like. When you create a version, the application does not need to make a copy of the master file, the information is efficiently stored in the XMP file or catalog, so you can create as many versions as you like without taking up much storage space.

The application automatically saves each edit that you make to a photo, so your editing workflow between photos is smooth. A complete history is kept for all the photos that you have imported into your Library, so you undo or redo changes at any time. Note, if you are working on photos that have not been added to the Library, the edit history is only retained for the current editing session. For more information, see “Using the History palette” on page 97.

About adjustment tools

Most editing tools and controls can be found in the Tools panel. When you click the Standard tab, you can access the Basic Adjustments section, which contains the most common adjustment controls. Other tabs, such as Color, Tone, Detail, and Metadata, let you access additional tools and more advanced controls and options. For example, the Basic Adjustments section includes Fill Light. Fill Light also appears in the Exposure section of the Tone page. In the Exposure section, there is an additional control, Fill Range, that lets you fine-tune the Fill Light adjustment. Adjusting Fill Light in one place will update the Fill Light setting in all sections — these are just different views of the same control.

The image below shows , and some common controls. The Tools panel can be resized, sections can be pinned, and you can choose to hide or show the panel. There are different ways to adjust the controls in the Tools panel. You can also reset controls to their original setting and hide or show the results of a setting.
Why are some tools and controls not available?

Some tools and controls are not available under the following conditions:
• The file that you are trying to edit is not available (for example, the files are stored on an external drive that is not currently connected to the computer)
• If you have a layer or selection and the tool or control can be applied only to entire images
  The tool is not compatible with the file format. For example, the following tools can be applied only to RAW files:
  • Custom White Balance (Temp and Tint sliders)
  • White Balance Presets (Sunny, Cloudy, Incandescent, etc...)

To resize the Tools panel
• Position your pointer along the left edge of the panel, and drag when your pointer changes to the resizing arrows.

To pin a section of a panel
• Display the section you want, and click the Pin icon pin in the upper-right corner. To unpin the section, click the icon again.
  A pinned section always displays, regardless of which page is active.

To hide the Tools panel
• Click the Toggle Right Panel button at the top of the panel.

To adjust a setting
• Do one of the following:
  • Drag the slider
  • Double-click the corresponding number for the setting and type a new value
• Using a mouse with a wheel, position your pointer over the control name or slider, and roll the mouse wheel to adjust the setting.

**To reset a slider to its original setting**
• Double-click the slider or control name.

**To hide or show the results of a setting**
• In the Tools panel, mark or unmark the check box to the left of the adjustment tool.

**Standard tools**

When you click the Standard tab on the Tools panel, you can access some of the most commonly used image editing tools. Grouping these frequently used adjustments together in one place means that you can perform basic edits quickly without switching between tabs. The controls are divided into three sections: Histogram, Basic Adjustments, and Presets.

**Histogram**

A histogram is a visual representation of the data that makes up your image. The left side represents the darker areas in your image, the right side represents the highlights, and the height of the colored curves shows you how many pixels of a given value are found in your image.
Basic Adjustments

This section holds the most commonly used image adjustment controls. Many photographers will likely find most of the controls they need in this section.

AutoLevel

AutoLevel examines the tonal range of your image and sets the black and white points to be at points such that a fixed percent of the image will be pure black and pure white. There are two edit boxes in AutoLevel: the left box sets the percentage of the image to be set to pure black and the right box sets the percentage to be set to pure white.

Perfectly Clear

Perfectly Clear, powered by Athentech Technologies Inc., is a simple way to quickly optimize your images. Perfectly Clear is award-winning technology that automatically optimizes the lighting for each and every pixel while maintaining true color and zero clipping. Perfectly Clear also removes abnormal tint and restores faded photos. It also uses medical imaging technology to improve contrast and sharpen.

There are three settings within Perfectly Clear that control how much tint adjustment is performed when Perfectly Clear is enabled:

• Tint Max — applies the full range of tint correction
• Tint Min — limits the tint correction, allowing some tint change to occur, but preserving some of the original tint
• Tint Off — tint correction is turned off. All other aspects of Perfectly Clear are still applied. Use this setting to preserve the color of your original image.
White Balance

For RAW images, you can select among several preset white balance settings, such as As Shot, Click White, and Custom Kelvin.

Different light sources have different characteristics or warmth that affects how your camera captures images. White Balance lets you adjust the overall color in the image, ensuring that colors are accurately reproduced in your photos. You can select a White Balance preset, such as Sunny, Shady, Tungsten, or Flash, or you can use the Click White tool (on RAW, JPEG, or TIFF files) to select a neutral colored object in your image (something that should appear as a neutral gray) which will adjust all the colors in your image to make the point that you clicked neutrally colored.

To set white balance with the Click White tool
1  In the White Balance section of the Basic Adjustments page, click the Enable the Click White tool button or press I.
2  In the Preview panel, experiment by clicking a neutral area of your photo. The ideal place to click is on a neutral grey that is not overexposed (pure white) or underexposed (pure black) on the image you want to adjust. Clicking different spots will result in different corrections.
3  To fine-tune the white balance, adjust this with the Temp slider.

Straighten

Straighten rotates your image to level a horizon or otherwise straighten your image. For more information, see “Straightening” on page 89.
Exposure

Exposure performs an overall exposure correction, either brightening or darkening all portions of your image.

Highlights

Highlights recovers detail from apparently overexposed portions of the image. For more information, see “Tone tools” on page 63.

Fill Light

Fill Light brightens shadows and the darker portions of the image without overexposing highlights, and with minimal effect on midtones.

Blacks

Blacks controls the black point in the image. Values lower than zero remove black from the image; values higher than zero darken the image. The Histogram section displays the changes in the image.

Saturation

Saturation adjusts the intensity of the colors in the image. High saturation settings boost colors and provide rich, vivid color. Low saturation settings produce pastel and more muted colors. Setting Saturation to zero produces a pure monochrome, black-and-white image.

Vibrance

Vibrance is a version of saturation that performs a more gentle correction to skin and other image areas that are already richly saturated.
Hue

Hue changes the colors in an image, rotating the "color circle" by the amount indicated by the slider. For example, if the Hue slider is set to 60, then 60 is added to the original hues in your image, so greens become cyan, blues become magenta, and reds become yellow.

![Color Circle Diagram]

Contrast

Increasing Contrast makes the dark areas in the image darker, and the bright areas brighter.

Sharpening

Sharpening an image makes the high detail portions of the image stand out more by making the edge details more pronounced.

Note: Fine detail control tools like Sharpening should be applied and evaluated while looking at a 100% Zoom of the image, either in the Preview panel or by using the Magnifier.

RAW Noise

RAW Noise reduces noise in RAW files only.

Keywords

The bottom of the Basic Adjustments section includes a Keywords area that shows the keywords for all selected versions. When you have multiple versions selected, the following color coding is used:

- red — the keywords apply only to some of the selected versions
• **green** — the keywords apply only to the active version
• **no color** — the keywords apply to all selected versions

**Presets**

Presets are a great way to help speed up your workflow. You can save your favorite adjustments to presets, create keyword presets, or combine a wide range of photo editing in a preset that can be applied with one click.

For more information, see “Working with Presets” on page 90.

**Color tools**

The **Color** tab in the Tools panel lets you access tools focused on color control. The controls are organized into five sections: **Curves**, **Color Correction**, **Color Balance**, **White Balance**, and **Color Management**.

**Curves**

The **Curves** section is an intelligent combination of standard Curves and Levels tools found in many image editing programs.
The **Curves** section includes the following controls:

- **Apply Curves** — enables or disables **Curves**.
- **RGB** drop-down — allows selecting of individual color channels, or the combined RGB mode.
- **Before/After** drop-down — switches the display from showing the histogram before curve adjustments are applied and after adjustments are applied.
- **Left White Arrow** — sets the input 255 (white) point. Dragging this arrow down shifts the histogram left, making the image darker.
- **Bottom White Arrow** — sets the output 255 (white) point. Dragging this arrow to the left brightens your image, but it can clip highlight details.
- **Left Black Arrow** — sets the input 0 (black) point. Dragging this arrow down shifts the histogram to the left, making the image darker.
• **Bottom Black Arrow** — sets the output 0 (black) point. Dragging this arrow to the right deepens the shadows, and can clip shadow detail.

• **Bottom Grey Arrow** — sets the output 128 (gray) point. Dragging this arrow to the right shifts the midtones to higher values, brightening the image; dragging the arrow to the left darkens the image.

• **Click inside the Curve** tool — click inside the curve tool itself to set or adjust the curve. You can set multiple points and drag to fine-tune your tone control.

• **AutoContrast** — click this button to set the output white and black points based on image content. It uses the AutoLevel values (highlight and shadow) to perform a one-time adjustment to increase contrast. The main difference between this tool and AutoLevel is that the output white and black values can be more easily adjusted than the AutoLevel values.

• **Black Point** tool, **Gray Point** tool, **White Point** tool — click a tool, then click the image in the Preview pane to set the black, gray, or white point to the values of the pixel that you click.

• **Reset All** and **Reset Current** — Reset All restores the curve values to a flat curve. Reset Current resets the current RGB channel only.

### Color Correction

The **Color Correction** section of the Color page in the Tools panel lets you adjust your image selectively based on colors that you sample from your image or colors that you set in the **Color Picker**. The colors you select are stored in color wells. The first six color wells (top row) are preset to the primary and secondary colors. The second set of color wells (bottom row) can be set to any color you choose.
To pick a color as the starting point for a color correction

1. In the Tools panel, click the **Color** tab, and open the **Color Correction** section.

2. Click any adjustable **Color Well** that isn't assigned a color (white wells in the second row).

3. Click the **Color Picker** that appears next to the Hue slider and click anywhere within your photo to select a color that will be used for color adjustment.

   After your starting color is selected, you can adjust the **Hue**, **Saturation**, or **Luminance** of that color within your image.

4. Adjust **Range** to control the color tolerance. A small range adjusts only colors very close to your selected color; a higher range adjusts a larger color range in your image.
In this example, Selective Color was used to sample the dress. The Hue was adjusted to change the color of the dress.

Tip: You can also assign a new color to a color well by clicking the color well that displays to the left of the Color Picker. This opens a color selector window where you can pick a color as your adjustment color.

**Color Balance**

This section in the Tools panel lets you precisely balance the colors in your image. You can use the following controls:

- **Cyan/Red, Magenta/Green and Yellow/Blue** — shifts the color along the color axis.
- **Saturation** — adjusts the intensity of the colors in the image. High saturation settings boost colors and provide rich, vivid color. Low saturation settings produce pastel and more muted colors.
- **Vibrance** — applies a gentle version of Saturation that avoids the oversaturation of skin colors and image areas that are already richly saturated.
• **Hue** — changes the colors in an image, rotating the color wheel by the amount indicated on the slider. For example, if the **Hue** slider is set to 60, this value is added to the original hues in your image, so greens become cyan, blues become magenta, and reds become yellow.

![Color Wheel Image]

• **HSL/HSV** — choose between correcting images in HSL (Hue / Saturation / Luminance) and HSV (Hue / Saturation / Value) color spaces.

**White Balance**

**White Balance** provides several preset white balance settings, such as **As Shot**, **Click White**, and **Custom Kelvin**.

Different light sources have different characteristics or warmth that effects how objects appear to you camera. **White Balance** lets you adjust the overall color in the image, ensuring that colors are accurately reproduced in your photos. You can select a **White Balance** preset, such as **Sunny**, **Shady**, **Tungsten**, or **Flash**, or you can use **Click White** to select a neutral colored object in your image (something that should appear as a neutral gray) which adjusts all the colors in your image to make the point that you clicked neutrally colored.

**To set white balance with the Click White tool**

1. In the **White Balance** section of the **Basic Adjustments** page, click the **Enable the Click-White tool** button or press I.
2 In the Preview panel, experiment by clicking a neutral area of your photo. The ideal place to click is on a neutral grey that is not overexposed (pure white) or underexposed (pure black) on the image you want to adjust. Clicking different spots will result in different corrections.

3 To fine-tune the white balance, adjust the Temp slider.

**Color Management**

This tool controls the color management mode applied to the active version.

- **Color Mgmt** — enables color management when set to an ICC profile. Switching this to None-Linear still applies color management, but leaves the image in a linear color space.
- **Custom Input Profile** — advanced users can choose to create an input profile from the linear data associated with a camera profile.

For more information, see “About color management” on page 211.

**Tone tools**

The Tone tab on the Tools panel lets you access controls that let you fine-tune image tone. All the tools are organized in the Exposure section.

**Exposure**

The Exposure section combines all the tonal adjustments into a single area. Many of the same controls can be accessed by clicking the Standard tab.
- **AutoLevel** — examines the tonal range of your image and sets the black and white points to be at points such that a fixed percentage of the image will be pure black and pure white. There are two edit boxes in AutoLevel: the left box sets the percentage of the image to be set to pure black and the right box sets the percentage to be set to pure white.

- **Blacks** — controls the black point in the image. Values lower than zero remove black from the image; values higher than zero darken the image.

- **Exposure** — adjusts the overall brightness or tone of the image

- **Highlights** — recovers highlight details and color from overexposed portions of your image.

- **HR Range** — controls how much of the image is adjusted by Highlights. Lower numbers recover detail and color from only the lightest areas; higher numbers expand the recovery to a broader range of light areas.

- **Fill Light** — recovers shadow details by selectively brightening only the darkest portions of your image
• **Fill Range** — controls how much of the image is adjusted by Fill Light. A small range adjusts only the darkest image areas; a large number brightens more of the midtones.

• **Contrast** — controls the difference between the lightest and darkest areas of an image. Increasing the contrast makes the dark areas in the image darker and the bright areas brighter.

• **Enable Local Contrast** — enable the check box to control regional contrast to improve overall image clarity or emphasize texture. Tonal changes are applied according to the values set for **Strength** (amount) and **Radius** (size of areas sampled).

  ![Local Contrast was applied (right) to emphasize texture in the original image (left).](image)

**Detail tools**

The **Detail** tab on the Tools panel lets you access controls that let you sharpen, blur, adjust noise, apply lens corrections or distortions, and add effects, such as vignette or color inversion.

**Sharpening**

The **Sharpening** section lets you adjust how sharp or how soft the details are in your image. **Amount** adjusts the overall sharpness, while **Sensitivity** limits what portions of your image are sharpened.
A high Sensitivity value results in less of your image being sharpened.
If sharpening your image makes noise or highly detailed areas too
distracting or too sharp, then try raising the Sensitivity value.

Note: Fine-detailed control tools, like Sharpening, should be
applied and evaluated while looking at the image at the 100%
zoom level, either in the Preview panel or with the Magnifier.

RAW Noise

RAW Noise is an image improvement process that you can use very
eyearly in the image editing workflow to provide the highest quality final
images. The feature can be applied only to RAW files.

- **Raw Impulse Noise Removal** — enables the automatic detection
  and removal of impulse noise (single black, white, or colored
  pixels).
- **Raw Noise** — reduces noise. You can control the strength of the
  noise reduction.
- **Threshold** — sets the level of sensitivity for noise detection in the
  image.

Note: Applying RAW Noise enables RAW Impulse Noise Removal,
but you can apply RAW Impulse Noise Removal without enabling RAW Noise.
Perfectly Clear Noise Removal

Perfectly Clear Noise Removal uses Athentec Imaging Noise Removal to improve images by reducing noise, a graininess caused by color or luminance-related artifacts, without losing image detail. Noise occurs for a number of reasons, including low-lighting or limitations of the camera's sensors. Perfectly Clear Noise Removal includes the following controls:

- **Enable Noise Removal** — toggles noise removal on or off.
- **Preset** — lets you choose automatic noise reduction based on some common noise-reduction options.
- **Strength** — lets you set how much noise reduction is applied (0-100).
- **Detail** — lets you control how much detail is preserved (0-10).

Lens Correction

Lens correction fixes lens distortion. While zoom lenses with a large range of focal lengths show the greatest lens distortion, even fixed-focal length, or "prime" lenses, can cause some types of distortion. The following types of lens distortion can quickly and easily be corrected in Corel AfterShot Pro: Barrel and Pin Cushion distortion, Chromatic Aberration, and Vignetting.
Barrel and Pin Cushion distortion is commonly referred to simply as lens distortion. This is caused from nonuniform magnification of the image from the outside of the image (perimeter) to the center. Barrel distortion refers to a rounded effect in an image caused by diminished lens magnification towards the edges. Pin cushion distortion refers to a pinched or narrowed appearance at the sides of an image. Each lens has its own Barrel and Pin Cushion characteristics, and by analyzing a set of images from a lens at all focal lengths, this distortion can be removed. Corel AfterShot Pro includes profiles for several hundred lens and camera combinations.

Chromatic Aberration distortion (known as CA distortion) is a result of the nonuniform bending of light as it passes through a lens. The result is a color fringe (often appears purple) and uneven colors around edge details in high contrast scenes, such as branches of a tree silhouetted against a bright sky. Zoom lenses, particularly at their
widest and longest focal lengths, exhibit the most severe distortion. CA distortion can be removed by adjusting the data for the colors that show the most distortion.

**Vignetting** is the darkening of corners of an image due to light fall-off, and can be caused by optics (the lens itself), the sensor (many sensors are less sensitive to light that hits the sensor at an angle), or from other causes like a filter or lens hood that shades the corners of an image. Vignetting can be corrected by brightening the corners of an image. In some cases, photographers chose to add a vignette effect to their photos to draw focus to the central subject. You can use Corel AfterShot Pro to remove an unwanted vignette or add a vignette. When you add a vignette, it is always performed on the cropped portion of the image, while correcting vignette is applied to the entire original frame.

Add a vignette

The **Lens Correction** section contains the following common controls:

- **Enable correction** — toggles **Lens Correction** on or off.
- **Resize image** — enable to automatically scale the image to fill the image frame. Do not enable if you want to fill the empty sections of your image manually.
- **Edit** — lets you edit the currently selected lens correction profile
- **Load** — lets you open a saved lens correction profile (XML file)
• **Save** — lets you save your changes to the current profile and save a copy as an XML file that can be shared with other users.

• **Reset** — removes all changes made to the profile during the current session.

The **Database** tab is used when you want to correct your images based on camera and lens profiles built into Corel AfterShot Pro.

The top section controls Barrel and Pin Cushion distortion, and contains two tabs: **Database** and **Manual**.

• **Manufacturer, Model, Lens** — these drop-down menus show what camera and lens Corel AfterShot Pro assumes your image was taken with. Some cameras and lenses include data in the image file that allows the application to determine exactly what camera and lens was used, but other times the application "guesses" the closest option based on the data available. You can change incorrect guesses by selecting the correct manufacturer, camera model, and lens in the lists. These determine which Lens Distortion profile to use when removing distortion.

• **Focal Length** — shows the focal length setting for the lens at the time the image was taken. You can set the focal length manually if the image file doesn't include this information.

• **Reload EXIF** — click this button to have Corel AfterShot Pro read the EXIF data from the selected image, guess the camera and lens type, and select the appropriate entries in the drop-downs.

The **Manual** tab lets you manually enter correction parameters instead of using correction parameters from profiles built into the application. This is useful for lenses that are not yet in the lens correction database. You can save a lens correction that you create as an XML file and share it with the AfterShot community. You can load saved lens corrections and edit existing profiles in the **Manual** tab.
If you want more information about lens correction parameters in general, and how to determine them, you can visit the following third-party site: http://wiki.panotools.org/Lens_correction_model.

The **Chromatic Aberration** section contains the following controls:

- **Chromatic Aberration Correction** — toggles Chromatic Aberration Correction on or off. This control is independent of other types of lens correction.
- **R / C** — controls the shift of colors along the Red/Cyan color axis.
- **B / Y** — controls the shift of colors along the Blue/Yellow color axis.

The **Vignette Correction** section contains the following:

- **Enable vignette correction** — toggles Vignette control on or off. This control is independent of other types of lens correction.
- **Strength** — controls how light (positive or right) or dark (negative or left) the correction will be.
- **Radius** — controls how far into the image the correction should extend.

**Mirror and Invert**

This simple tool allows you to:

- **Mirror** your image (from left to right).
- **Invert** the colors (like a film negative). This option can be useful when working with scanned negatives.

**Metadata tools**

The Metadata tab contains tools that let you view and edit the metadata associated with your images. This metadata includes camera data, EXIF and IPTC data, as well as information that you add to your files, such as keywords, star ratings, and captions. The controls are
organized into three sections: Metadata, Keywords, and Keyword Sets.

**Metadata**

This tool shows EXIF and IPTC metadata assigned to the Active Version, and allows you to add, remove or edit the IPTC data from all selected images.

You can select different metadata sets from the drop-down list at the top of the Metadata section, which changes the type of metadata that is shown. Some metadata is read-only, like Shutter Speed and ISO Rating, while other metadata is editable, like Caption, Rating, and Date.

**Keywords**

This section shows all keywords assigned to the active version and all selected versions. You can add and remove keywords from all selected images.
**Note:** Adding or removing keywords from the Keywords section affects all selected images, while the keywords displayed in the section reflect only the active version.

**Keyword Sets**

This section provides a fast and easy way to assign multiple keywords to your photos. You can group similar keywords together in a set and show that set in the **Keyword Sets** section.

For more information about **Metadata** tools, see the following topics:

- Working with metadata
- Effective use of keywords
- Working with keywords and keyword sets
- Finding photos by using metadata

**Plugins**

The **Plugin** tab lets you access installed plugins, including plugins developed by third-party developers. These unique image adjustment tools are designed to work directly within Corel AfterShot Pro. The plugins are totally non-destructive, like all of Corel AfterShot Pro's built-
in image adjustment tools, and are compatible with Corel AfterShot Pro's selective editing tools.

As you install other plugins, additional tools appear on the Plugins tab. Additional tabs are created automatically as you install more plugins.

For more information about plugins available for Corel AfterShot Pro, visit www.aftershotpro.com/plugins.

![Before and after showing the original photo (left) and the results from the Black-and-White plugin (right).]

Installing and updating plugins

The easiest way for Windows and Mac OS users to install a plugin is from the Plugin Manager available from the Get More tab. For Linux users, and to get general information about plugins, visit www.aftershotpro.com/plugins.
Plugins are distributed as Corel AfterShot Pro .bzplug files — a single file that contains all the files and information necessary for the plugin to run.

**To install a plugin from the Plugin Manager**

1. On the tools panel, click the Get More tab.
2. Open the Plugin Manager section.
3. To the right of the content that you want to install, click the download button.

   By default, the download buttons display Install, Free, or a price.
4. Follow any instructions for downloading or purchasing the content.
   The content is installed. You might need to restart your application to activate some types of content.

**To manually install a plugin (outside the Plugin Manager)**

- Do one of the following:
  - Double-click a Corel AfterShot Pro plugin bundle (which ends with the .bzplug file extension).
  - Drag and drop a .bzplug bundle into the Browse panel.
  - Click File > Install Plugin and choose the .bzplug bundle that you want to install.

**Note:** Corel AfterShot Pro checks to make sure the plugin you are trying to install supports your version of Corel AfterShot Pro and your computer type. In some cases, an updated version of the plugin will be installed. You must restart Corel AfterShot Pro to complete the installation process. You can restart immediately after installing or updating a plugin, or you can restart later.
Corel AfterShot Pro Black & White Plugin

Corel AfterShot Pro includes the Black & White Plugin which lets you choose from a variety of color mixing options and use an innovative spot color tool that restores one or two colors to your black and white image.

The original photo (left), black and white version (center), and spot color version (right)

This plugin includes the following controls:

- **Enable Black & White** — turns the effect on or off.
- **Channel Mixer** drop-down list — lets you choose from several color mixes used to determine the black and white value.
- **First Spot Color** and **Second Spot Color** tabs — sets the spot color restoration options.
- **Enable** — turns the spot color effect on or off.
- **Hue** — specifies the hue to be restored. You can also click the Color Well to choose a color.
- **Fuzziness** — sets the range for the restoration based on how close the colors are to the selected hue.
Selective editing

Selective Editing lets you isolate adjustments or edits to a specified area of a photo. For example, you can select and lighten an area that you want to highlight in a photo, or select an area that you want to edit by using Heal, Clone, or Blemish Remover. For more information about Heal, Clone, and Blemish Remover, see “Retouching with Heal, Clone, or Blemish Remover” on page 84.

Selective Editing has three main steps:

1. Create a layer — See “To create an adjustment layer” on page 80.
2. Select one or more areas to edit by creating regions — See “To create a region” on page 81.
3. Apply adjustments — See “To adjust a layer” on page 82.

Review the information below to learn about layers, regions, and adjustments that can be used with selective editing.

Layers

Layers are collections of regions and adjustments. A layer can contain a single region and adjustment, or it can contain many regions and adjustments. All regions in a single layer will have the same adjustments applied. For example, if you want to brighten several faces in a photo, you can create circle regions over each face, and then adjust the Fill Light setting for the layer, thereby brightening the shadows for all the selected faces at one time. You can apply other adjustments to the layer as well, but at the point where you don't want the adjustments to apply to all the selected regions, or you want to adjust a new region, you must create a new layer and select one or more regions that you want to adjust.
The upper area of the Layers palette contains the main commands for creating and managing layers, including the Region tools. You can add, delete, duplicate, invert, and rename layers. You can also copy and paste layers — the selected areas and layer settings are copied.

The Name list on the Layers palette shows all the layers associated with the current version of the photo. You can choose a layer to view the selected regions in the Preview panel. You can also choose which layers and regions to show or hide.

The lower area of the Layers palette is context-sensitive. It displays settings that you can use to control and fine-tune the active tool.

**Regions**

Regions are selected areas of a photo that you create by using one of the Region tools:
• **Circle Region** tool — creates a circular region.

• **Polygon Region** tool — creates a polygon region (triangle, square, rectangle...). The enclosed shape is determined by clicking the image to set points which are connected by straight lines.

• **Curve Region** tool — creates an irregular curvy shape. The enclosed shape is determined by clicking the image to set points which are connected by curved lines.

• **Brush Region** tool — creates a freehand shape. Brushstrokes determine the selected region. You can create the entire region with a brush, or use a brush to add to a region. For example, you can use the Polygon Region tool to select a large area of a background and then use the Brush Region tool to add small brushstrokes around the borders of the background to ensure that you have complete coverage.

Regions have two areas: the main area and the feather area. The main area is the portion within the solid lines of a region, and this is where the full effect of editing applies. Along the edge of the main area is the feather area. This is the transition area where the selected area blends with the background — from 100% at the inside edge, to 0% at the outer edge of the dashed line.

To have a smooth, gentle fade between a region and the rest of the image, use a large feather size. To make sharp, crisp regions that affect only the selected area inside a region, use a very small feather size.

![Image of region](image.png)

*The main part of the region is enclosed by a solid black line. The feather area is enclosed by a dashed white line.*
Regions can also be inverted, so that the edits applied to the layer containing a region will apply to the portion of the image that is outside the selected area.

**Adjusting regions**

After you have created a layer with one or more regions that you want to edit, you can use controls in the Tools panel to apply adjustments.

Some adjustments and editing tools are designed to work on the entire image and cannot be applied to a layer. The following adjustments and tools affect the entire image:

- Image Rotation
- Straightening
- Lens Distortion Correction
- Color Management
- AutoLevels
- All Metadata settings (keywords, ratings, labels, IPTC data, etc)

**To create an adjustment layer**

1. In the upper-right corner of the application window, click the **Open Layer Manager** button.

2. In the **Layers** palette, click the **+ Adjust** button.

A new layer appears in the **Name** list, below **Main Layer**.

**To set layer opacity**

- In the **Layers** palette, click a layer name, and adjust the **Opacity** slider at the bottom of the palette.

**To rename a layer**

- In the **Layers** palette, double-click a layer name in the **Name** list, and type a name.
Tip: You can name your layer according to the type of adjustment you want to make. Later, if you want to make the same adjustment to another region, it will be easy to choose the existing layer and add a region.

**To duplicate a layer**

- In the Layers palette, click the layer that you want to duplicate and click the **Duplicate** button.

**To hide or show a layer or region**

- In the Layers palette, click the box to the left of a layer or region name in Name list.

  A check mark appears in the box when the layer or region is visible. The box is empty when the layer or region is hidden.

**To delete a layer or region**

1. In the Layers palette, click the name of the layer or region that you want to delete.

2. Click the **Delete** button at the top of the Layers palette.

**To create a region**

1. In the Layers palette, create or select a layer to which you want to add a region.

2. Click one of the following Region tools:

   - **Circle Region** — In the Preview panel, click the image to set the position of the circle. At the bottom of the Layers palette, adjust the Size and Feather settings.

   - **Polygon Region** — In the Preview panel, click the image to set each point of your shape (the points are connected by straight lines). Double-click to complete the polygon. At the bottom of the Layers palette, adjust the Feather settings.
• Curve Region — In the Preview panel, click the image to set each point of your shape (the points are connected by curved lines). Double-click to complete the shape. At the bottom of the Layers palette, adjust the Feather settings.

• Brush Region — In the Layers palette, enable the Show Strokes check box. Adjust the Size and Intensity settings for your brush, and drag in the Preview panel to apply your brushstrokes. When you are finished, you can disable the Show Strokes check box. To fine-tune your brushstrokes, toggle between the Erase Brush and Normal Brush mode. If you want to change the color of your brushstrokes, click the Color well and select a color.

To invert a layer
• In the Layers palette, click a layer name in the Name list and click the Invert button.

The outline for the main area of a region changes from black to white when you invert.

To adjust a layer
• In the Layers palette, click a layer name in the Name list, and in the Tools panel, adjust the settings you want.

For information about which adjustments can be applied, see “Adjusting regions” on page 80.

Editing regions

Editing regions is just as easy as creating regions. You can edit a region by adding, deleting, or moving points on polygon and curved shapes. You can also move a region, adjust the size, or adjust the feathering.
To add a point to a polygon or curved region
1 In the Layers palette, click a region name in the Name list.
2 Hold down the Shift key down and in the Preview panel, position your pointer over the region outline where you want to add a point.
3 When a red circle appears at the correct position, click to add a point.

To delete a point from a polygon or curved region
1 In the Layers palette, click a region name in the Name list.
2 Hold down the Alt key down (or Alt+Shift on some Linux systems) and in the Preview panel, position your pointer over the point that you want to remove.
3 When a red circle appears on the point, click to delete the point.

To move a point on a polygon or curved region
1 In the Layers palette, click a region name in the Name list.
2 In the Preview panel, position your pointer over the point that you want to move.
3 When a red circle appears on the point, drag the point to a new location.

To move a region
1 In the Layers palette, click a region name in the Name list.
2 In the Preview panel, position your pointer over the region.
3 Drag the region to a new location.

To resize a region
• In the Preview panel, position your pointer over a region and roll your mouse wheel to make it larger or smaller.
Blending layers

Blending allows you to "cut out" sections of a region by creating new regions below the initial region and setting Blending to Subtractive. This will subtract the lower regions from any areas where they overlap with higher regions. A Subtractive region that does not overlap with Additive regions above it will have no effect. You can check layer order by looking at the Name list in the Layers palette.

To use a Subtractive layer when blending layers

1. In the Layers palette, click the name of the layer that you want to change to Subtractive or create a new layer.
2. Choose a Region tool, and from the Blending drop-down list, choose Subtractive.
3. Create a region that protects lower regions from the Additive layers above it.

Retouching with Heal, Clone, or Blemish Remover

Heal, Clone, and Blemish Remover let you remove small, distracting elements from your photos. They use layers and Region tools in a similar way to selective editing.

- **Heal** mode is best used for small blemishes in smooth, low detail areas, such as a small blemish on skin, or a small bird in the sky. It is limited only to circular regions created with the Circle tool, and unlike cloning, it does not require that you set a source.
- **Clone** mode is the process of copying a part of an image in order to cover up a distracting or unwanted feature in the picture. Cloning takes image content from a source region and places it in the selected area.
- **Blemish mode** combines smart healing with cloning. Because you can use the Circle, Polygon, or Curve Region tools and choose a source, Blemish mode is more versatile than Heal. The source area
you choose is analyzed along with the selected area to produce more seamless coverage. You can activate Blemish mode by choosing the Blemish Remover tool on the AfterShot toolbar.

Each version can have only one Heal/Clone/Blemish layer. Copying and pasting a Heal/Clone/Blemish layer replaces any existing Heal/Clone/Blemish layer.

**Switch between Heal, Clone, and Blemish**

You can use the Circle tool in Heal, Clone, or Blemish mode. To switch between these modes, simply choose Heal, Clone, or Blemish from the Mode drop-down list in the Layers palette. The control is visible after you select an area, and only the modes available for the region type created are available in the drop-list.

**To remove a spot with Heal**

1. Click the Open Layer Manager button.
2. In the Layers palette, click the +Heal/Clone button.
3. Click the Circle Region tool, and in the Preview panel, click the spot that you want to remove.
4. In the lower-left corner of the Layers palette, choose Heal from the Mode drop-down menu.

If you want to adjust the size of the circle or how the edges of the circle blend, drag the Size or Feather sliders at the bottom of the Layers palette.
The Heal mode was used to remove a small white spot from a flower

To cover or copy image areas by cloning

1. In the Layers palette, choose an existing Heal/Clone/Blemish layer or click the +Heal/Clone button to create a Heal/Clone/Blemish layer.

2. Click a Region tool.

3. Select the portion of your image that you want to clone out. This is the destination area for the cloning.

   For information about using regions tools, see “To create a region” on page 81.

4. Ensure the Mode is set to Clone.

5. After you finish creating your destination region, a source region is automatically created (outlined in red). Click and drag the source region to position it over the image content that you want to copy.

   Tip: When cloning, you can click the Swap Source button at the bottom of the Layers palette to swap the source region with the destination region. This is useful when you want to
duplicate content in an image instead of using cloning to remove image content.

To remove an unwanted area with the Blemish Remover

1. On the AfterShot toolbar, choose a Region tool from the drop-list. The Brush Region tool is the only option that is not available for the Blemish Remover.

2. Click the Blemish Remover tool.

3. Select the portion of your image that you want to remove.

4. After you finish creating your destination region, a source region is automatically created (outlined in red). Click and drag the source region to position it over the image content that you want to use as a source.

5. In the Layers palette, ensure the Mode is set to Blemish.

6. Adjust the Feather and Size slider to blend the edges of the selection and cover the area.
Removing red eye

When light from the camera’s flash reflects off the retina of a person's eye, a red-eye effect is captured in the photo. You can remove the red eye effect with the Red Eye tool.

To remove red eye

1. In the AfterShot Pro toolbar, click the Red-eye Removal tool. A circle appears in the Preview panel.
2. Drag the circle to the eye area.
3. Adjust the size of the circle to match the size of the red eye by using the Size slider in the popup.
4. Click the mouse button to remove the red from the eye.

Cropping

Cropping lets you recompose your photo, remove unwanted edge areas, or change the aspect ratio to match a print output. For information about preferences related to cropping, see “Crop preferences” on page 189.
To crop a photo

1. Click the Crop tool crop on the AfterShot Pro toolbar or press C.
2. In the Cropping palette, do one of the following:
   • Choose a preset from the crop preset drop-down menu.
   • Choose Aspect or Pixels from the Crop mode drop-down menu, and type values in the Height and Width boxes.
3. Drag the edges of the cropping grid that appears in the Preview panel to adjust the crop area.
4. Click inside the cropping grid to reposition the crop area.
5. In the Cropping palette, click Done.

You can also

| Automatically maximize the crop region to the edges of the photo | Click the Fit button. |
| Display or hide the cropping grid | Click the Enable Crop check box. |
| Switch the orientation of the cropping grid | Click the Switch height and width button. |
| Lock the aspect ratio of the cropping grid | Click the Lock button. |
| Add a crop preset to the preset drop-down list | In the Cropping palette, enter the Aspect or Pixel values you want, and click the Add button. |

Tip: You can use the scroll wheel on a mouse to resize the cropping grid.

Straightening

Straightening lets you correct tilted horizons or apply a creative tilt to your photos.
To straighten a photo

1. Select the **Straighten** tool from the AfterShot Pro toolbar or press **S**.
2. Drag in the Preview panel to draw a horizontal or vertical line that you want to use as a reference for straightening the photo.
3. Release the mouse button to apply the changes.

*The Straighten tool lets you choose a reference point (emphasized above by a red line) for straightening*

**Note:** When you straighten a photo, the photo is not cropped automatically, so you will see white areas along the edges of the photo.

### Working with Presets

Using presets is a great way to speed up your workflow. You can save your favorite adjustments to presets, create keyword presets, or combine a range of photo editing in a preset that can be applied with one click.

Presets are saved as XMP files in the Corel AfterShot Pro user folder on your computer:

C [a main drive]:\Users\[User name]\AppData\Local\Corel\AfterShot Pro\Presets
This makes it easy to copy presets from one computer to another, or to share presets with others.

You can also import Presets by clicking the Get More tab and installing the presets you want. For more information, “Updating and extending the application” on page 219.

Applying and managing presets

Applying a preset essentially applies all the commands and information to the selected files. All the actions appear in the History palette, making it easy to remove any settings that cause an undesired effect.

Many presets can be applied to an image, and each subsequent preset replaces the settings of previous presets with the settings contained in the last preset.

Corel AfterShot Pro includes quite a few presets, but you are encouraged to create your own presets.

Managing presets

You can manage your presets. When you open the Manage mode, you can create preset folders and move, rename, delete, and view preset settings. Corel AfterShot Pro includes several default presets. You can
create as many additional folders as you need to categorize and organize your photos. You can also choose which presets display in the My Favorites list (the drop-down list on the Presets section title bar).

To apply a preset
1. In the Thumbnail panel, select the image or images that you want to edit.
2. In the Tools panel, click the Standard tab.
3. In the Presets section, click a preset in the list. Presets are applied to all selected images, except when in Multi-Image View mode.

To create a preset
1. Edit an image, using all the commands and settings that you want to save to the preset.
2. In the Tools panel, click the Standard tab.
3. In the Presets section, click the Add Preset button.
4. In the Save Presets dialog box, pick a name for the settings, and choose which settings you want to save.
5. Click OK to save the preset. The preset name appears in the preset list immediately.

To access the Manage mode for presets
1. In the Tools panel, click the Standard tab, and open the Presets section.
2. Click the Manage button in the lower right corner of the section.

To add or remove a preset to the My Favorites list
- In the Show in Menu column, mark a check box to display the corresponding preset in the My Favorites drop-down list; unmark the check box to remove the preset from the list.
To create folders for presets

1. In the Presets Manage mode, click the Add Folder button.
2. Double-click the new folder that appears at the bottom of the preset list and type a name for the folder.

To move presets

- In the Presets Manage mode, drag a preset from one folder to another folder.

To rename presets or preset folders

- In the Manage mode, double-click a preset or folder in the list, and type a new name.

To delete presets or preset folders

- In the Manage mode, click the preset or folder that you want to delete, and click the Delete button or press Delete on your keyboard.
  
  Tip: You can undelete a preset by clicking Edit > Undo or by pressing Ctrl + Z.

To view the settings for a preset

- In the Manage mode, click the preset and click the View preset settings button.

Copying and pasting settings

You can copy some or all the settings from one photo and paste the settings to other photos. For example, you can adjust the exposure, color, noise, and sharpness of a photo and apply metadata and keywords. After the photo is perfect, you can copy the settings and
paste them to as many similar photos as you want. This is a great way to edit and optimize many images very quickly.

The general process is:

1. Make adjustments to one image.
2. Copy all image settings or selectively copy only some of the settings.
3. Select one or more photos to which you want to apply the settings.
4. Paste the settings to the selected photos.

Copying selective settings lets you filter out settings you don't want to apply, such as crop, GPS, or layer settings. If you selectively copy settings regularly, you can create copy sets, which save the information about which settings you want to copy. For more information, see “Copy Sets preferences” on page 188.

**To copy all settings**

1. In the Thumbnail panel, click the file that has the settings that you want to copy.
2. Click Edit > Copy Image Settings. All settings and layers are copied from the active version.

**To copy selective settings**

1. In the Thumbnail panel, click the file that has the settings that you want to copy.
2. Click Edit > Copy Selective Image Settings.
3. In the Select Settings dialog box, enable the check boxes for the settings that you want to copy.
4. Click OK to copy the settings.
Note: The Basic page lists the settings. The check boxes beside each setting indicate if the setting is selected or not. Checked groups are those whose settings on the active version differ from the default image settings for that version. When some settings differ from the default settings, the check boxes are partially checked.

Note: You can enable (check) or disable (uncheck) additional groups — only the checked and partially checked settings are copied. To see details about the settings, click the Advanced tab.

To paste settings

1. In the Thumbnail panel, select the thumbnails to which you want to apply the settings.

2. Click Edit > Paste Image Settings.

Undoing changes

There are some handy ways to undo one or more actions.

To undo an action

• Select a thumbnail, and do one of the following:
  • Press Ctrl + Z or Command-Z.
  • To reset a Tools panel slider to its original setting, double-click the slider name.

To undo multiple actions

• Select a thumbnail, and do one of the following:
  • At the bottom of the Tools panel, click the Reset All button.
  • Right-click the thumbnail, and choose Settings > Apply Default Settings or choose Apply Initial Settings from the
context menu. For more information, see “About default settings” on page 96.

About default settings

When Corel AfterShot Pro first opens or imports an image, it looks for a Corel AfterShot Pro settings file for that image. If it finds one, it applies the settings in that file as the initial settings. If a Corel AfterShot Pro settings file cannot be found, Corel AfterShot Pro applies default image settings to the image.

Note: If you have imported your photos into a catalog, the initial settings are stored and you can quickly revert to these settings at any time.

You can customize the default settings so that you can apply your favorite adjustments to every image that Corel AfterShot Pro opens. You can also apply image adjustments with presets, so it is recommended that you keep your default settings basic and use presets for more specific settings.

Corel AfterShot Pro comes with two different defaults, one for RAW image formats, and another for rendered images like JPEG and TIFF files. Since rendered files are likely to have been adjusted by the camera or other editing software, the defaults for rendered images applies no additional sharpening or other adjustments. You can replace these defaults with customized default settings, or create defaults specific to the make and model of camera that you use.

To change the default settings

1. Select an image of the same type as the defaults you want to save. This should be either a JPEG or TIFF if you want to save new rendered default settings, a RAW file if you want to save default settings for all RAW formats, or the image should be from the
camera make and model if you want to save camera default settings.

2 Make the adjustments to the current image, applying only the settings you want to save as the default settings.

3 Right-click or **Control**-click the thumbnail, and choose **Settings** from the context menu.

4 In the submenu, select the type of default you want to save

Any new images that Corel AfterShot Pro opens will use the new default settings as that image's initial settings.

**To view or remove custom defaults**

1 Click **File > Preferences**, and choose **Default Settings** from the preferences list.

2 In the **Default Settings Files** list, make the changes you want.

**To apply default settings**

- Right-click a thumbnail in the Thumbnail panel, and click **Settings > Apply Default Settings**. This applies the current default settings for that image type, camera make, and model.

**To apply initial settings**

- Right-click a thumbnail in the Thumbnail panel, and click **Settings > Apply Initial Settings**. This reverts to the image settings that were used when the image was first imported into the **Library**. If working in **File System** mode, the initial settings are those that Corel AfterShot Pro started with at the beginning of the current editing session.

**Using the History palette**

Corel AfterShot Pro keeps a list of all the edits and adjustments you make to every image in your catalogs. At any time, you can open the
History palette to see what changes have been made to the active version.

If you are working in File System mode, then the History palette contains only the edits from the current session — previous edits are not retained.

To open the History palette
• From the View menu, click History.

To review edits with the History palette
• In the History palette, click an editing action in the list. The photo will temporarily display the state of the photo up to the selected editing action — hiding all the edits you've performed between the action you selected and the most recent edit.

To return to the last edit step, simply click the last step in the list.

Editing photos in an external image editor

You can open an external image editor, such as Corel PaintShop Pro, Adobe Photoshop, or Adobe Lightroom, from within Corel AfterShot Pro. You can choose a default external image editor and set the format, color space, and dpi settings that apply when you export images to the
external editor. At any time, you can change your external editor settings in the Preferences. For more information, see “External Editor preferences” on page 190.

To assign an external editor to a toolbar button

1 On the top toolbar, click the Edit in External Editor button. A configuration dialog box opens.
2 In the Editor drop-list, choose an image editing application from the list or click Choose and navigate to the application .exe. The application icon and application name appear in the Editor box after you select the .exe.
3 Specify the File Format, Color Space, and dpi settings you want, and click OK. The icon for the application you chose displays in the top toolbar.

To open a photo in the external image editor

- In the Thumbnail panel, select one or more thumbnails, and do one of the following:
  - On the top toolbar click the Edit in External Editor button (button displays the icon of the assigned image editor)
  - Right-click or Control-click a thumbnail, and choose Edit with [external editor].
  - On the menu bar, click Edit > Edit with [external editor].
Corel AfterShot HDR

In photography, HDR refers to “high dynamic range”. Dynamic range is the range of luminance that can be captured in a photo, from the darkest shadows to the brightest highlights. HDR processing lets you combine two or more RAW photos of the same scene that have been taken with different exposure settings. Best results are achieved when the photos are taken with a tripod or very steady hand. An auto-bracketing feature on your camera makes it easy to capture sets of photos at different exposures. For high contrast scenes, such as sunsets or a photo of a room interior with a large bright window, HDR processing merges photos and creates a more even exposure that lets you resolve details in the darkest areas without losing definition in the bright areas.

In this section, you’ll learn about

• Working with Corel AfterShot HDR

Working with Corel AfterShot HDR

Corel AfterShot HDR has three components that let you achieve HDR results:

• Exposure Merge — lets you merge one or more photos to achieve an HDR effect. You have access to presets and custom controls to get the results you want.
• Single RAW Photo — lets you simulate an HDR effect from one RAW photo by using HDR tools.
• Batch Merge — lets you merge one or more sets of photos, normally captured on a camera that uses an auto-bracketing
setting. This feature offers a fast way of merging multiple sets of photos. There are very few controls. It's a great way to identify sets of photos that you might want to fine-tune in Exposure Merge.

For more details about Corel AfterShot HDR, see the Help that is available from the Corel AfterShot HDR application window.

**To open Corel AfterShot HDR**

1. In Aftershot Pro, select the thumbnails you want to use for HDR.
2. Right-click a selected thumbnail and choose **Edit with AfterShot HDR** from the context menu.
Organizing images

Corel AfterShot Pro offers many ways for you to organize and sort your images.

In this section, you’ll learn about

• Versions
• Stacks
• Thumbnail indicators
• Sorting
• Filtering
• Labels
• Ratings
• Flags

Versions

Versions are used in Corel AfterShot Pro to represent your master files and any variations derived from your master files. When you make edits and image adjustments in Corel AfterShot Pro, you are creating and editing versions, not the original master file. This means you can make as many different versions from a single master file as you like, without ever affecting the original image.

Versions created from the same master file share the same content and are shown in a stack — a set of thumbnails that can be grouped together so that only the top thumbnail shows in the Thumbnail panel. All settings and options can be different, allowing you to make different interpretations, crops or other image adjustments to each
version. Versions maintain their own edit history, and can each be assigned unique metadata. The settings for all versions from a single master file are stored inside a single Corel AfterShot Pro XMP file.

Many operations are possible with versions, and many of these are available on the context menu, found by right-clicking on a thumbnail and selecting the Version menu option.

**Creating versions**

Corel AfterShot Pro automatically creates a master version for each master file in the folder you are viewing. There are several ways to create another version of a photo.

*In the example above, the thumbnail on the left is the master version. To the right are two additional versions that have been edited. The number 3 appears on the lower left corner*
of the master version thumbnail to indicate the total number of versions.

To create a version

- In the Thumbnail panel, right-click an existing version, click Version in the context menu, and choose one of the following options:
  - **New Version from Current** — creates a new version with the same settings as the selected version's current settings.
  - **New Version from Master** — creates a new version with the same settings as the master version's current settings.
  - **New Version from Import** — creates a new version with the same settings that the selected version had when it was imported.
  - **New Version from Defaults** — creates a new version with the default image settings for this type of image. For more information, see “About default settings” on page 96.

**Note:** When Multi-Image View is enabled, only the active version is the source for the new version.

What happens when a version is deleted?

Deleting a version removes the settings and adjustments made to that version, and removes that version from Corel AfterShot Pro. If the version you are deleting is a master version, then the master file is moved to the Recycle Bin. For more information about deleting versions, see “Deleting versions” on page 41.

Stacks

Stacks are a visual means of grouping similar images together. Stacks are either Open — with all images in the stack visible, or Closed — with only the topmost image in the stack exposed. Stacks are groupings of versions, and each stack is contained in one catalog.
At the top is a closed stack. You can open and close stacks by clicking the icon in the upper-left corner of the master version.

**Using stacks**

In **File System** mode, stacks are used only to group multiple versions from one master file.

In the **Library**, stacks can serve many purposes and you can use them for a variety of organizational tasks. For example, you can use stacks to group shots from a burst of images (continuous shooting) or made from exposure bracketing. You can select the best shot from the group to display as the top image. You can also stack a set of images that you will use to build a multi-image panorama or that you will otherwise combine into a single image in another application. Or, you can use stacks to group similar images together so it's easier to browse through your images.

When you create a new version from an existing version, the versions are placed in the same stack. You can remove these versions from the stack if you want.
**Sorting stacks**

When sorting the thumbnails in the Thumbnail panel, versions within stacks are not sorted. This is to maintain the manual sort order that you can specify for a stack and ensures the top version stays on top.

The entire stack is sorted in the Thumbnail panel in the location specified by the top image.

You can change the sorting order within a stack by dragging-and-dropping the versions, or by using the commands in the context menu.

**Editing images in a closed stack**

When editing the top image in a closed stack, only the top version is modified. This includes changes to metadata and ratings.

**To create a stack**

1. Select the versions that you want to stack.
2. Right-click and choose **Stacking > Stack** or from the menu bar, click **Edit > Stacking > Stack**.

   **Note:** You can make new stacks only when viewing a single folder and not when viewing catalog folders recursively.

**To add versions to a stack**

1. Select the versions you want to add to a stack.
2. Do one of the following:
   - Drag and drop that version onto a stack.
   - Right-click a stack and select **Stacking > Stack**.
   - From the menu bar, select **Edit > Stacking > Stack**.

**To remove versions from a stack**

1. Select the versions that you want to remove from the stack.
2 Do one of the following:
   • Drag and drop the version outside the stack.
   • Right-click and select Stacking > Unstack.
   • From the menu bar, select Edit > Stacking > Unstack.

**To merge two or more stacks**
1 Select the versions in the stacks that you want to merge.
2 Right-click and select Stacking > Stack.

**Thumbnail indicators**
The Thumbnail panel and the thumbnails themselves show a great deal of information about your images and the metadata applied to them.

![Thumbnail showing some of the thumbnail badges.](image)

The table below explains the thumbnail indicators:

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Indicates the image is a version (not master version)." /></td>
<td>Indicates the image is a version (not master version).</td>
</tr>
<tr>
<td><img src="image" alt="Indicates that Corel AfterShot Pro cannot find the master file associated with this image, and is thus &quot;offline&quot;. You can view a preview of the image, if one exists, and can still edit metadata, but you cannot make other types of edits." /></td>
<td>Indicates that Corel AfterShot Pro cannot find the master file associated with this image, and is thus &quot;offline&quot;. You can view a preview of the image, if one exists, and can still edit metadata, but you cannot make other types of edits.</td>
</tr>
<tr>
<td><img src="image" alt="Indicates the version has Flag as Pick applied." /></td>
<td>Indicates the version has Flag as Pick applied.</td>
</tr>
<tr>
<td>Indicator</td>
<td>Function</td>
</tr>
<tr>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td><img src="Image" alt="Reject Flag" /></td>
<td>Indicates the version has Flag as Reject applied.</td>
</tr>
<tr>
<td><img src="Image" alt="Cropped Image" /></td>
<td>Indicated the version has been cropped.</td>
</tr>
<tr>
<td><img src="Image" alt="Image Adjustments" /></td>
<td>Indicates the version has had image adjustments applied.</td>
</tr>
<tr>
<td><img src="Image" alt="Rating Stars" /></td>
<td>The number of stars indicates the Rating that has been set for this version.</td>
</tr>
<tr>
<td><img src="Image" alt="Color Label" /></td>
<td>Indicates the Color Label that's been applied.</td>
</tr>
<tr>
<td><img src="Image" alt="Stack Indicator" /></td>
<td>Indicates the version is the top image in a stack of three images</td>
</tr>
</tbody>
</table>

**Sorting**

You can sort thumbnails by a wide range of attributes.

- Name of the Version
- Date the image was taken
- Rating
- Label
- Flag
- Shutter Speed
- Focal Length
- F-Number
- ISO
- Custom - used when dragging thumbs to set a custom ordering

**Note:** Stacks appear in the list of thumbnails in order of the top item in the stack. The images within the stack are ordered manually, so they may not appear in the same order as the rest of the thumbnails.
**Custom sort order**

Besides the sort orders based on metadata (like name or rating), you can also specify a manual sort order to put your images in any order you want.

Custom sorting is only possible when:

- viewing a single folder (not recursive)
- filtering is disabled

**To apply a custom sort order to your images**

1. Select a single folder, disable filtering, and turn off recursive folder browsing.
2. Then, switch the Select Sorting to Custom.
3. Drag the thumbnails into the order you want.

**Filtering**

Filtering thumbnails temporarily removes them from the Thumbnail panel, allowing you to focus on a smaller set of images. You can use simple filtering rules, like "Rating–More than or equals–3 stars" or you can use more complex filtering.

**To filter images**

1. Ensure that the images you want to filter are displayed in the Thumbnail panel.
2 On the AfterShot Pro toolbar, click the **Show Filter Tool** button.

3 Modify any of the following settings:
   - **Rating**, **Label**, and **Flag** check boxes enable or disable the filtering for those items, while the drop-down menus and buttons on the right let you select the conditions and what to show.
   - **Always show selected versions** — lets you add the filter results to the currently selected images. If you unmark this check box, only the filter results display in the Thumbnail panel.
   - **Require all of the conditions above** — requires that all **Rating**, **Label**, and **Flag** conditions match in order for those images to appear in the Thumbnail panel. This is equivalent to an AND search. If this option is unchecked, then versions meeting ANY of the conditions show in the Thumbnail panel.

   **Note:** Filtering remains on until you unmark the **Rating**, **Label**, and **Flag** check boxes.

**Labels**

“Labels” are actually Color labels that let you categorize your images visually. There are five colors and the unlabeled state. Color labels are often used to categorize images by purpose or edit status. For example, you can assign a red label to images that need post-processing or heavy retouching. You can assign a blue label to images that are part of a panorama or another series.

You can also use color labels to indicate the status of your images. For example, you can assign a yellow label to images that you have posted to your photo-sharing website, green labels to images that you have sold to a client or stock agency, and red labels to images in your catalog that have restricted copyright usage.
It is best to be consistent and complete when you use a color label system.

Each version can have only one color label, so try to avoid using labels for status or indicators that are not mutually exclusive. For example, an image could have both restrictive copyright usage and could be posted to a photo-sharing website. It is better to use keyword hierarchies for status indicators that are not mutually exclusive.

To assign a color label
1. In the Thumbnail panel, select the images that you want to label.
2. On the Top toolbar, click the Label drop-down menu and choose a color.

   The color labels appear in the upper-right corner of the thumbnails.

   **Tip:** You can also assign a color label to a thumbnail by positioning your pointer over the bottom right corner of a
thumbnail and clicking the color label icon to display and choose a color.

Ratings

Star ratings are a great way to help you to find your best images quickly. You can assign ratings to images in your catalog to quickly select or filter images.

To assign star ratings

1. In the Thumbnail panel, select the images that you want to rate.
2. Do one of the following:
   • Click one of the stars on the Top toolbar.
   • Press Ctrl + [1,2,3,4, or 5].

Flags

You can use flags to pick (Flag as Pick) or reject (Flag as Reject) images. You can also clear flags that you assign (Clear Flag). Flagging is a great way to quickly assess images. You can also use flags to mark images that you are in the process of editing or you can flag several images with similar content so you can quickly select and compare them when trying to select the best version.

You can flag a file or version as reject to help you keep your catalog free of out of focus or otherwise poor quality images. One workflow would be to scan through new images, flagging the poor quality images as Reject. After all images have been reviewed, use the filter to show only the rejected images to verify that you marked only the poor quality images, then permanently delete the Reject images. You can also keep images that you flag as Reject — after they are flagged as Reject, they do not show up in the standard view of your Catalog, while leaving them on your computer just in case you do need that image later.
To flag images

1  In the Thumbnail panel, select the images that you want to flag.

2  Do one of the following:

   • Click the Flag as Pick [Flag as Pick] or Flag as Reject [Flag as Reject] buttons on the Top toolbar.
   • Press . (period key) to pick or press , (comma key) to reject images.

   If you want to clear a flag, click the Clear Flag button [Clear Flag].

   Tip: You can also mark a version as rejected, Alt+Click (Option+Click on Mac, Alt+Shift+Click on Linux) on the flag indicator.
Keywords

Keywords are words that you associate with your image files. They are used to help you and others search through many images to find what you are looking for. You can use standard keywords or custom keywords. For example, you can add keywords to identify image content, client or job, or the location where images were taken.

In this section, you’ll learn about

• Effective use of keywords
• Working with keywords and keyword sets

Effective use of keywords

Searching for the keyword "family vacation" is a lot easier than remembering where you stored your photos, but for keywording and searching to be effective, you need to add keywords to your photos in a way that you can easily remember. For example, if you search for "family trip" but assigned the keyword "family vacation" to your images, your search will return nothing and you won't find what you are looking for.

Before adding many keywords to your images, it is a good idea to think through and plan how you want to use keywords. Corel AfterShot Pro has a couple of features that help you create and organize keywords effectively: keyword hierarchies and keyword sets.
Keyword hierarchies

Corel AfterShot Pro supports keyword hierarchies, so you can create subcategories of keywords. For example, you can organize the keywords "dog" and "cat" (child keywords) under "pets" (parent keyword) or "Mom" and "Dad" under "Family". A keyword hierarchy helps you keep your keywords organized and makes it easier to find categories of images. You can create keyword hierarchies in the Keyword Manager or by typing a semi-colon between keywords in the Keywords section.

Hierarchy example

You could create three top level keyword groups: "Clients", "Subject Matter", and "Genre". Then add new sub-keywords to the "Clients" group for each job you work on and add entries under "Subject Matter" for things like "Urban", "Landscapes", "Portrait", "Head-shot" and so forth. Under "Genre" you could have "Sepia", "High Key", "Black & White", "Bleach Bypass", "High Contrast" and any number of other image treatments or photographic genres. As you import images from a new shoot, you can assign the keyword "Clients;Smith Wedding". As you edit and optimize your images, add "Subject Matter" keywords. As you make multiple versions of your images, some in Sepia, some in Black & White, tag these versions with "Genre" keywords.

Now, you can quickly search for any image shot as part of "Smith Wedding", or you can find all of your "High Key" images. Or search for High Key images shot during the Smith Wedding that are Portrait.

All the keywords at a specific level in a hierarchy must be unique, but you can have the same keyword in different hierarchies. So you can have "John Doe" under "Clients", and "John Doe" under "Subjects". This allows you to distinguish between images shot of John Doe, and images shot for John Doe. You can perform a search for "John Doe" and find both.
Keyword Sets

Keyword sets let you quickly display a group of keywords that are meaningful to the set of images you are working with. You can group similar keywords together in a set and show that set in the Keyword Sets section. This means that you can assign keywords quickly by clicking them in the Keyword Sets section rather than retyping them each time in the Keywords section. Keywords within a keyword set can come from anywhere in a keyword hierarchy. For example, you can make a keyword set that includes all the family members that went on vacation together, destination names, and any other subject matter relating to that shoot.

You can switch between keyword sets. For example, if you took photos at a family wedding, you can use a Family set that lets you name people quickly and then switch to a Wedding set that lets you apply the keywords you typically assign to wedding shots: Bride, Groom, Cake, Reception, Flowers, etc...

You can create keyword sets in the Keyword Manager.

Working with keywords and keyword sets

There are two ways to assign keywords in Corel AfterShot Pro: type keywords in the Keywords section or assign keywords that you've added to the Keyword Manager and then apply them by choosing them in the Keyword Sets section. You can delete keywords from your images and delete keywords or keyword sets from the Keyword Manager at any time. You can also assign shortcut keys to your keywords and keyword sets.
The Keyword Manager helps you organize your keywords

To assign a keyword by typing it in the Keywords section
1. In the Thumbnail panel, select the images to which you want to add keywords.
2. In the Tools panel, click the Metadata tab.
3. In the Keywords section, type the keywords that you want to assign. Use the following syntax:
   • Use commas (,) to separate keywords (for example: Mom, Paris, vacation)
   • Use semi-colons (;) to create keyword subcategories (hierarchy) (for example: Travel; France; Paris)
4. Press Enter.

To assign a keyword by choosing it from a keyword set
1. In the Thumbnail panel, select the images to which you want to add keywords.
2. In the Tools panel, click the Metadata tab.
3 In the **Keyword Sets** section, choose a keyword set from the drop-down menu in the title bar.

![Keyword Sets](image)

4 Click a keyword in the main area of the **Keywords Sets** section to apply it to the selected images.

**To create a keyword set**

1 In the Tools panel, click the **Metadata** tab.
2 In the **Keyword Sets** section, click the **Manage** button.
3 In the left pane of the **Keyword Manager**, do one of the following:
   - Find existing keywords that you want to add to your set.
   - Add keywords as a subcategory of an existing hierarchy. For example, to add the names of family members, you could click **Subject > People > Family**, and click the **Add Child Keyword** button ![Add Child Keyword](image). Type a name to add it as a subcategory of Family.
   - Create a new hierarchy by clicking the **Add Keyword** button ![Add Keyword](image) and typing a keyword. To create subcategories, select a keyword and click the **Add Child Keyword** button ![Add Child Keyword](image).
4 When you know that you have all the keywords for your set, click the Add Set button below the right pane and type a name for your keyword set. You can type any name, it does not need to match any existing keywords.

5 From the keyword list in the left pane, drag the keywords to the set name in the right pane. The keywords that you drag are what you will see in the set list, regardless of their place in the hierarchy (does not affect hierarchy in any way).

6 Click the Close button at the top of the Keyword Manager window.
   Your set now appears in the Keyword Sets drop-down menu.

To remove a keyword from an image
1 In the Tools panel, click the Metadata tab.
2 In the Thumbnail panel, select an image.
3 In the Keywords section, select the keywords that you want to remove and press Delete.

   Note: When you delete a keyword, look at any remaining hierarchy references to see if you need to delete the entire hierarchy associated with the keyword.

To delete a keyword or keyword set from the Keyword Manager
1 In the Keyword Sets section, click the Manage button.
2 In the Keyword Manager, do one of the following:
   • Click a keyword in the left pane and click the Delete Keyword button.
   • Click a keyword set name in the right pane and click the Remove Set button.
To assign a shortcut to a keyword or keyword set

1. In the **Keyword Sets** section, click the **Manage** button.

2. In the Shortcut column, double-click the cell that aligns with the keyword or keyword set you want.

   An entry box appears.

3. On your keyboard, press the key or key combination that you want to use as a shortcut.

   If the shortcut has already been assigned, a message appears and lets you accept or cancel the keyword change.

4. Click the **Accept** icon to apply the shortcut.

   **Tip:** You can remove a shortcut from a keyword or keyword set by clicking the **Remove** icon.
Photo metadata, or information about your pictures, can make searching and finding your images much faster and easier. Metadata simply refers to the information about your images, including data recorded by your camera, such as the time, date, exposure, shutter speed, and aperture. You can also add your own metadata to photos to record what the subject is, where you took the photos, and professional photographers can include client information.

In this section, you’ll learn about
- Types of metadata
- Storing and sharing metadata
- Working with metadata
- Viewing metadata
- Editing metadata
- Managing metadata sets
- Finding photos by using metadata
- Metadata in images that you output
- Adding metadata in other applications

**Types of metadata**

Some metadata is standardized so it can be accessed by a wide range of devices and software. EXIF and IPTC are the most common metadata standards:
EXIF (Exchangeable Image File Format): Data typically recorded by the camera about the settings used for a photo. Most EXIF metadata is not editable. The EXIF data from the original photo (master file) is used for all versions that are derived from the master file (same source). Some examples of EXIF metadata are shutter speed, aperture, ISO, date, and time.

IPTC (International Press Telecommunications Council): Data added by the photographer such as image description, photographer information, copyright, and caption.

Corel AfterShot Pro also supports other metadata, some of which can be shared between different applications. This metadata includes:

- Keywords
- Ratings
- Color Labels
- Flags

**Storing and sharing metadata**

Not everything in Corel AfterShot Pro can be shared with other applications that support XMP files. Different applications have different methods of storing metadata, so some incompatibilities may exist. Corel AfterShot Pro saves all your image adjustments in XMP files; however, these changes cannot be seen in other applications. For example, if you adjust the exposure and saturation on a RAW file in Corel AfterShot Pro, these changes will be saved to the sidecar XMP file for that image. Opening the RAW file in Corel AfterShot Pro at a later date (with both the RAW file and XMP file in same folder) will show the image with the adjustments you've made: exposure and saturation. However, opening that same RAW file in other image editors will show the original RAW file, not the RAW file with your edits intact. In order to make the adjustments you've made in Corel AfterShot Pro visible to
other applications, you must export the RAW file to a editable format like JPEG or TIFF, then open that exported file in the other application.

Corel AfterShot Pro stores its settings in an XMP file that is slightly different than other popular image editors. For more information, see XMP files.

**Working with metadata**

Corel AfterShot Pro includes all the tools to you need to add, edit and view IPTC 4 XMP metadata as well as EXIF and other metadata.

Much of this metadata is also available in the Browse panel so you can quickly find any image shot at a specific location, annotated by a specific person, or otherwise labeled with metadata.

Corel AfterShot Pro divides the metadata into several groups to make it easier to view and work with the metadata. You can create as many additional groups of metadata as you like so you can display or edit the information more easily.

**Viewing metadata**

Select the Metadata tab from the Tools panel, then choose which metadata group you want to view from the drop-down list at the top of the Metadata section.
Editing metadata

All of the metadata fields shown in the Metadata section are editable by clicking to the right of the heading that you want to edit. Some metadata is read-only, such as EXIF information related to shutter speed and aperture.

Editing metadata affects only the active version.

Managing metadata sets

Creating and editing metadata sets lets you view and edit the metadata you want quickly. Click the Manage button in the lower-right corner of the Metadata section to open the Metadata Manager. The left column lists all metadata entries available in Corel AfterShot Pro. The right column lists metadata sets and their current content.
The **Metadata Set Manager** allows you to pick what metadata is shown in each metadata set, and to create new sets.

**To add a new metadata set**
- Click the **Add a new Set** button.

  A new set with the default name "New Set" is created at the end of the **Metadata Sets** list.

**To remove a metadata set**
- Select the set you want to remove and click the **Remove Set** button.

**To rename a metadata set**
- Double-click the metadata set that you want to rename, and type the new name.
To add metadata to a metadata set

- Select the metadata entry in the left column, and drag it to the metadata set in the right column.

Finding photos by using metadata

Assigning metadata to your images makes them much easier to find when you use the Search or the Metadata Browser. Both features only find images that have been imported into the Library. The catalogs must be open in the Library to use these features.

Searching for images

If you know exactly what keywords you are looking for, you can search your catalog for that content. Simply type the term you want to search for into the Search box at the top of the Catalogs section in the Browse panel, and press Enter to perform the search. The results are shown in the Thumbnail panel.

Browsing for images

You can use the Metadata Browser section to quickly find images shot on a specific date, with a particular camera, or any combination of the most common shooting information that is captured in the metadata fields or keywords. The number in parentheses beside the metadata category name indicates how many versions meet the criteria. The Metadata Browser is more precise than Search.
Link to catalogs

The contents and counts in the Metadata Browser are determined by the status of the Link to Catalogs check box at the top of the Metadata Browser:

- unchecked — the Metadata Browser shows contents and counts for all catalogs currently open in your Library.
- checked — the Metadata Browser shows only contents and counts for versions in the catalogs and folders that are selected in the Catalogs section. This can provide a very concise view of the metadata for the images in one or more folders.

With this control, you can filter out the metadata for portions of your Library. For example, if you have your Library organized by clients, you can select a specific client's folder in the Library. Then, by enabling Link to Folders, you can show only the keywords, cameras, dates, and other metadata for images shot for that client.

Refine

You can use Refine to limit what is shown in the Metadata Browser. Refining works by selecting an entry in the Metadata Browser, then clicking the Refine button to limit the search results that match the entry.

You can add entries as you refine in any order you want. For example, you can select three, four, and five stars from the Ratings metadata.
entry, then click **Refine**. The results show only your best images — the images that you have tagged with three or more stars. Then, you can select a year or month entry from the **Date/Time** area, and click **Refine** again to display your best images from a specific time frame. To remove an entry when refining, click the X button next to the entry.

The items you refine are highlighted in the **Metadata Browser** to remind you that only a portion of your **Library** is listed in the counts and contents of the **Metadata Browser**.

**Metadata in images that you output**

Metadata assigned in Corel AfterShot Pro can be passed along to the images that are output. By default, all EXIF and IPTC metadata is passed along to output images. Flags are not part of the EXIF or IPTC standards, so they are not output.

Keywords are included in the IPTC Standard, but have restrictions on the length and structure of the keywords.

- IPTC Keywords must be 64 characters or less in length. Keywords longer than this will be truncated.
- IPTC Keywords have a flat structure. Corel AfterShot Pro keyword hierarchies are flattened in the IPTC standard.

Corel AfterShot Pro also writes out keyword hierarchy information into XMP sections in a manner that can be understood by a growing number of applications that also use keyword hierarchies.

**Corel AfterShot Pro metadata in other applications**

If you use Corel AfterShot Pro's Asset Management and metadata editing features and want that metadata to be shared with external applications, you will need to export your metadata changes to a standard XMP file. Then tell the other applications to read the
metadata from those XMP files, updating their internal databases accordingly.

Disabling metadata output

When you output your files, you can choose whether to include or omit metadata in output files. By default, Corel AfterShot Pro will include EXIF, IPTC, and Corel AfterShot Pro metadata when you output.

Adding metadata in other applications

Corel AfterShot Pro will automatically import metadata that has been applied to images in other applications as long as the other applications support the EXIF, IPTC and XMP standards, and save their metadata in a proper and supported form. If you have applied or edited metadata to your images before importing the images into Corel AfterShot Pro, the metadata will automatically appear within Corel AfterShot Pro.

If you import images into Corel AfterShot Pro, and then edit and apply metadata using other applications, then you will need to Merge External Metadata to make Corel AfterShot Pro aware of the changes. This process includes:

1. Import images into Corel AfterShot Pro, and subsequently edit metadata using an XMP-compatible application.

2. Have the other application save the metadata to an XMP file for each image you have edited, or embed the metadata in the master file as XMP. If Corel AfterShot Pro has already created an XMP file for these images, then the other application should edit those XMP files instead of overwriting them.

3. Within Corel AfterShot Pro, select images you want to sync, and select Edit > Setting > Merge External Metadata from the main Corel AfterShot Pro Menu or the Context Menu.
The metadata syncing process will overwrite any data that Corel AfterShot Pro and the other application shared. So, if you had rated an image with 2-Stars in Corel AfterShot Pro, then rated that same image as 1-Star in another application before Syncing this file in Corel AfterShot Pro, the final rating in Corel AfterShot Pro will be 1-Star. Corel AfterShot Pro will merge changes made in both applications, but it will treat the data added by the external application (the data written to the XMP file) as authoritative and will update the Corel AfterShot Pro Catalog to match the contents of the XMP file.
Watermarks

Protect and promote your work with watermarks—visible text or logos that you add to your images. Deter unauthorized copying, brand your photos with your logo or contact info, or use the Watermark feature for its text capabilities—to add captions or a title to your images.

You can apply watermarks to individual photos or batches, and easily adjust size, rotation, position, transparency and more.

You can use text or an image (above) as your watermark.

In this section, you’ll learn about
• Watermark settings
• Saving watermarks as presets

**Watermark settings**

AfterShot Pro offers watermark settings that let you customize your watermark, while ensuring that you can control how the watermark is placed and sized on a variety on image sizes and orientations.

You can create an image-based watermark or a text-based watermark.

**Adding titles and captions**

The text capabilities in the Watermark section can also be used to add a title or caption to your photos.

*The Watermark section offers many controls that let you customize your watermark*
**Basic settings**

The **Basic** tab in the **Watermark** section lets you adjust the following settings:

- **Alignment** — determines where the watermark will be placed on the image
- **Base size** — the reference point for the **Size** of the watermark. For example, if you save the watermark and apply it to a batch of images that are different dimensions and orientations (portrait and landscape), the base size is used to ensure the watermark is the same relative size on each image.
- **Rotation** — rotates the watermark by up to 90 degrees clockwise or counterclockwise.
- **Size** — the size of the watermark as a percentage of the reference point set in **Base size** (maximum is 80% of full image)
- **H-Pos** — distance of watermark from the left or right edge, as a percentage of the total width
- **V-Pos** — distance of watermark from the top or bottom edge as a percentage of the total height
- **Opacity** — transparency level of watermark (percentage)

**Transformation settings**

The **Transformation** tab in the **Watermark** section lets you adjust the following settings:

- **H-Skew** — skews the watermark horizontally
- **V-Skew** — skews the watermark vertically
- **H-Project** — horizontal 3D style transformation (result appears as though watermark is spinning towards you or away from you)
- **V-Project** — vertical 3D style transformation (result appears as though the watermark is leaning forward or back)
- **H-Stretch** — stretches the watermark horizontally
• **V-Stretch** — stretches the watermark vertically

**Text settings**

When you add text to your image using the **Watermark** feature, you can adjust the following settings:

• **Font** — Click the arrow to the right of the font drop-list to choose a font

• **Italic, Underline, Bold, Strike out** formatting — Enable the check boxes to choose one or more of these text formatting options

• **Color** — Click the swatch to open the **Select Color** dialog box and choose a color for your text

**To add a watermark to an image**

1. In the Tools panel on the right, click the **Watermark** tab to open the **Watermark** section.

2. Mark the **Enable Watermark** check box.

3. Choose one of the following:
   • To use an image, click **Image**, and click the **Browse** button to choose a PNG or SVG file (usually the file will be a logo with a transparent background). Adjust the settings you want on the **Basic** tab.
   • To add text, click **Text**, and choose the settings you want on the **Basic** tab.

   If you want to customize your watermark further, click the **Transformation** tab to skew, project, or stretch the watermark.

4. To save your watermark for future use, click the **Save watermark** button (plus sign) near the top of the **Watermark** section.

   **Tip:** You can also use a JPEG for a watermark if you don’t have any transparent areas in your source image.
Saving watermarks as presets

You can save your watermarks as presets. As a preset, the watermark can be applied to one or more images. You can apply watermark presets as part of any batch operation that lets you apply presets (import, export, and printing, for example).

To save a watermark as a preset

1. After you create a watermark in the Watermark section, click Create Preset and type a name for your watermark in the Save Preset dialog box.

   You can now click the Standard tab on the Tools panel to find your watermark in the Presets section.
Exporting images

Because Corel AfterShot Pro is non-destructive, the adjustments made to images within Corel AfterShot Pro must be written out to a new image file before these adjustments can be seen in any other application. The process of exporting images is quick, while at the same time powerful and very configurable.

In this section, you’ll learn about

• About exporting
• Exporting without a batch preset
• Exporting with a batch preset
• Using batches with folders
• Pausing, resuming, and stopping batches
• Managing batches
• Understanding export settings
• Web Galleries
• Copying images

About exporting

There are two main ways to export photos:

• **Export** — you can use the Export command to export one or more selected photos (versions). This method does not use predefined batch settings, so each time you export, you choose the settings that you want.

• **Export with Batch Preset** — a batch preset uses a set of predefined settings to export one or more photos (versions). You
can configure batches with your favorite settings so you can process many images very quickly without having to choose a folder, image format, rename format, and other settings each time you export. This is often easier and faster to use than Export, even when you are exporting a single file.

**Output types**

There are three types of output that you can choose from when you export: File, Copy, and Gallery.

- **File** output is the most commonly used output type. For example, if you simply want to output your RAW file as a JPEG file, this is the file type to use. This output type creates a new image file in the format that you select. You can apply adjustments and resize the image. You can save to a predefined folder or specify new file names and folders by using renaming formats.

- **Copy** output is ideal for transferring images from a memory card to a specific location on your computer and importing files to your Library, all in one step. This output type copies source files (master file and sidecar file) to the folder of your choice. You can also automatically import the files after they are copied so that your catalogs and Library is up-to-date.

- **Gallery** output creates image and HTML files that let you create a Web gallery for your photos. Just upload all the files to your website.

**Exporting without a batch preset**

You can use the Export command to output one or more photos (versions) without using a batch preset (a set of predefined output settings). The dialog box displays the settings applicable to the export type you choose.
To output by using Export

1. In the Thumbnail panel, select one or more photos that you want to output.

2. On the menu bar, click File > Export, and choose Export Files, Make a Copy, or Create a Web Gallery. For more information about these output types, see “About exporting” on page 139.

3. In the Export To box, choose one of the following options:
   - Source Folder — save files in the same location as the original fileset
   - Choose Folder — click the Browse button to navigate to the folder you want to save in.

4. Specify any other settings you want. For more information about the settings, see “Understanding export settings” on page 146.

5. For JPEG files, you can type a value in the Quality box.

6. Select the file type (TIFF, JPG, etc) that you want to save to, any options associated with that file type, and any other options that you want to apply to the exported file.
7 Click OK when you're ready, and all selected files will be written to the folder you've chosen, with the settings you selected.

**Exporting with a batch preset**

You can output one or more photos (versions) to standard file formats by using a batch preset. Batches save you time by letting you output with your favorite settings by simply clicking a batch name. For example, Corel AfterShot Pro includes the following batches: **16-bit TIFF**, **8-bit TIFF**, **Download**, **Gallery**, **JPEG Full Size**, and **JPEG Proof**.

**What can I do with Download?**

Download is a unique type of batch that lets you copy images from a camera memory card to your computer. You can also copy to a new folder structure and rename files.

**To output by using a batch**

1 Select one or more thumbnails in the Thumbnail panel.

2 Do one of the following:
   - Click the Output tab, and in the Batch Output section, drag the thumbnails over a batch name.
   - In the Batch Output section, press the shortcut key associated with a batch.

The shortcut key for each batch is shown to the right of each batch name in the Batch Output section. For example, press F to send the selected versions to the JPEG Full Size batch.
Using batches with folders

You can output an entire folder of images by using a batch.

To output a folder of images by using a batch

1. In the Browse panel, click the Library tab or the File System tab, and navigate to a folder.
2. Right-click the folder and choose Send to batch (include subfolders), and choose a batch name.
   If the Select a destination dialog box appears, navigate to a folder, and click Select Folder.

Pausing, resuming, and stopping batches

Pausing a batch temporarily stops the processing of the batch. It will stop after the current versions finish processing.

You can toggle the pause state of any batch by simply clicking the Pause button on the progress bar next to the batch you'd like to pause. Corel AfterShot Pro processes several images at a time, so pausing will...
not stop the images that are currently in progress, so a couple more images will complete before the batch is fully paused.

Stopping a batch halts the process of converting files. Corel AfterShot Pro processes several images at a time, so the batch stops when it completes the versions that it is working on.

**To pause and resume batch processing**

- In the lower-left corner of the application window, click the **Pause** button. Click the button again to resume processing.

**To stop a batch**

- In the lower-left corner of the application window, click the **Stop** button to the right of the **Pause** button.

**Managing batches**

Corel AfterShot Pro comes with several pre-defined batches that perform many common operations. You can edit or adjust these any way you want and you can create your own batches that perform custom operations that match your workflow. For the steps in this section, you will click the **Output** tab on the Browse panel.

Many operations on batches, like those listed below, can be accessed from the context menu that is available when you right-click in the **Batch Output** list.

You can create a new batch or duplicate a batch. Sometimes it is easier to duplicate an existing batch, and make modifications to this new copy, instead of making a new batch from scratch. You can also rename an existing batch.

You can also assign a shortcut key to a batch. Assigning a shortcut key to a batch lets you add the currently selected versions to that batch by
simply pressing the shortcut key associated with that batch. For example, by default the F key is assigned to the JPEG Full Size batch, so at any time in Corel AfterShot Pro, you can simply press F to add the currently selected images to the JPEG Full Size batch and output JPEG files.

To create a batch
1 Click the Output tab.
2 Right-click a blank area of the Batch Output section, and choose New from the context menu.
3 In the Batch Export Settings dialog box, type a name in the Batch Name box.
4 Choose the settings that you want to use for the batch.

To duplicate a batch
1 Click the Output tab.
2 Right-click a name in the Batch Output section, and choose Duplicate from the context menu.

To delete a batch
1 Click the Output tab.
2 Right-click a name in the Batch Output section, and choose Delete from the context menu.

To rename a batch
1 Click the Output tab.
2 Right-click a name in the Batch Output section, choose Rename, and type a new name for the batch.
Tip: You can also double-click (slowly) a batch name in the Batch Output section, type a new name, and press Enter when finished.

To assign a shortcut key to a batch

1. Click the Output tab.
2. Right-click a batch name in the Batch Output section, and choose Set shortcut from the context menu.
3. Press the key or key combination that you want to use for a shortcut. The shortcut appears in the Set shortcut dialog box.

Understanding export settings

When you export your files, whether you use a batch preset or not, you can specify the settings. The settings available depend on the type of output. For example, if you choose to output a JPEG Full Size batch, the settings are very different from the settings you choose for a Gallery.

By having multiple tabs in the Batch Export Settings dialog box, you can create multiple output types within a single batch. For example, you can create small thumbnail images, large Web-viewable images, and full size TIFF images with a single click.
The Export dialog box and the Batch Export Settings dialog box contain the following settings categories, depending on the type of output: Image Type and Size, Output Name and Location, Additional Image Settings, Metadata, and Post Processing. For more detailed information about the settings in these categories and general settings, see the descriptions in the topics below.

**Batch Name**

The Batch Export Settings dialog box includes the following controls:

- **Batch Name** — identifies the batch that you are using. This is also an entry field when you create a new batch.
- **Output tabs** — let you add more than one output when you run a batch. You can choose from three output types: File, Copy, Gallery. A tab appears for each output type.
Click the plus sign on the tab to add another output to your batch preset.

Export To

Export To determines where the files will be saved. You can choose from the following options:

- **Ask Before Export** — prompts you for a location (Select a Destination dialog box) each time you export.
- **Ask Once Per Session** — prompts you for a location the first time you export and uses the same location each time you export until you close the application.
- **Choose Folder** — saves the exported files to the same folder every time you run the batch. Use the **Browse** button to set the fixed destination. For example, if you automatically sync a folder on your computer with an online photo sharing service, you can create a batch preset that saves the photos you want to share to this folder.
- **Source Folder** — saves the exported files in the folder specified in the text box relative to the folder that contains the master files that you are exporting. For example, entering "Converted" in the text box would tell this batch to create a subfolder called "Converted" in each of the folders where the original master files are stored. The output files are saved within the "Converted" folders.
Image Type and Size settings

Image Type lets you choose a file format type. If you choose JPEG, you can set a value in the Quality box.

- **Image Size** allows you to alter the size of your output images and choose scaling quality.
- **Normal / Proof** — select the quality for scaling the image. **Proof Quality** produces images that are half-height and half-width of the original image.
- **Do Not Resize** — maintains the same pixel dimensions as the original image file.
- **Resize Width/Height** — resizes the output image to fit within the specified dimensions. Enter a maximum pixel **Width** and pixel **Height** in the boxes to the right.
- **Resize Long/Short** — resizes the output image to fit within the specified dimensions. Enter a maximum value in pixels for the long and short edge of the output image in the boxes to the right. Long/Short resizing lets you specify a non-square bounding box that the output image will be fit into, regardless of the landscape/portrait formatting of the image.
- **Do not enlarge** — similar to **Resize to Fit** except that small images will not be expanded to fit the specified dimensions.

  **Note:** For more information about resizing, see About image size.

Output Name and Location settings

This section controls how Corel AfterShot Pro names the files that you're outputting.

You can choose a preset renaming format from the drop-down list, or you can type the formatting codes in the box below the drop-down
list. For more information about renaming formats, see “Renaming formats” on page 193.

- **Save in subfolder** — lets you specify a subfolder so that images from different output tabs in the same batch are output to different folders. For example, you can create thumbnails on one tab and save them in a subfolder named "thumbs" and save full size JPEG images into a separate folder using a single batch. This folder is specified relative to the overall batch destination.

- **Overwrite existing output files** — replaces existing files that have the same name with those being created with the latest batch.

- **Ask for job name each time** — if you use the [jobname] renaming variable as part of the renaming format, it ensures that you are prompted to choose a job name each time images are sent to this batch. If this option is not checked, the last job name for the batch is used.

**Additional Image Settings**

This section lets you apply presets or metadata to your images before creating output images. Multiple presets can be added to a single batch. The presets are applied in the order in which they appear. You can drag presets to reorder them in the list.

- **Add Preset** button — lets you to add a preset to apply to your output images.

- **Remove Selected Preset** button — lets you remove a preset.

- **Output Color Space** — lets you convert the color space. Note that this can affect the color, contrast, and overall look of your output images, so we recommend that you soft proof to preview the effect on specific images.
Metadata settings

This section provides control over the metadata included in the files that you are outputting. You can also set the DPI.

- Embed EXIF — writes EXIF data to the output file, including shutter speed, aperture, and other shooting data.
- Embed XMP — writes metadata to the output file in XMP.
- Embed IPTC — writes metadata to the output file in IPTC format as well as legacy IPTC formats.
- Embed color profile — includes the color profile in the output file.
- Embed Copyright — includes copyright information regardless of the EXIF or XMP embedding options.
- DPI — lets you enter a DPI value for the files. This does not affect the pixel size or file size of the resulting image. For more information about resizing, see About image size.

Post Processing settings

This section lets you perform additional adjustments after each image has been converted.

- Output Sharpening — applies additional sharpening to images. Output sharpening is a standard USM process or unsharp mask sharpening.
- Open with [application] — lets you launch an external application at the end of the output process.

Web Galleries

Corel AfterShot Pro helps you share your images with Web galleries. Some of the settings on the Gallery tab are shared with other batch settings. For more information, see “Understanding export settings” on page 146.
The **Gallery Settings** area includes the following settings:

- **Gallery Type** — lets you choose a layout.
- **Gallery Heading** — sets the label at the top of each gallery webpage.
- **Gallery Title** — set the gallery title in the title bar of the Web browser.
- **Display Metadata** — lets you choose the metadata set that you want to include on the details page for each image.
- **Thumbnail image size** — sets the height and width for thumbnail images.
- **Preview image size** — sets the height and width for preview images.

**Gallery types**

There are three gallery types available and a view of the **Full Image** page included with all three types. The types are:

**Columns** — Thumbnails are presented in multiple columns. Multiple pages are created as required.
- Selecting a thumbnail shows a preview image on the right.
- Clicking the preview shows the image in a separate page.

**Single Row** — Thumbnails are presented as a single scrollable row on a single page of images.
• Selecting a thumbnail shows a preview image above the thumbnails.
• Clicking the preview shows the image in a separate page.

**Grid** — Thumbnails are presented in a grid that fills the screen. Multiple pages are created as required.
• Selecting a thumbnail shows the image in a separate page. There is no preview image.

**Full Image** — Included in each of the other gallery types, Full Image is a single image view with links to the previous and next images.
• Basic shooting information displays below the image if your preferences are set to export EXIF information (default).
• Displays an IPTC caption below the image and the IPTC Image Name displays as the heading, if your preferences are set to export IPTC information (default).
Keyboard navigation

The galleries created by Corel AfterShot Pro offer mouse and keyboard navigation. When viewing your gallery using a Web browser, you can use the following keys:

- **Arrow keys** — use to select a thumbnail that you want to preview. The **Grid Gallery** style does not include preview images.
- **HOME** — selects the first image in your gallery.
- **END** — selects the last image in your gallery.
- **Page Up** — goes to the previous page of thumbnails (not available with Row Style galleries).
- **Page Down** — goes to the next page of thumbnails (not available with Row Style galleries).

On pages that show a single image, you can use the following keys:

- **Left / Right Arrow Keys** — goes to the previous or next page.
- **Home** — returns to the Gallery Index.

Metadata Information

The image name under thumbnail images displays the IPTC Image Name if this has been defined, and if not the filename will be displayed.
The image caption under preview images will show the IPTC Caption if this has been defined, and if not the filename will be displayed.

On the Full Image Page, the Title is set to IPTC Image Name if it is defined, and filename otherwise. The IPTC Caption is shown with basic EXIF shooting information at the bottom of the page.

**Advanced Gallery Editing**

The pages that make up the web gallery are standard HTML, CSS, and Javascript files. After a Web Gallery has been created by a Web Gallery Batch, you may customize these pages using a Text Editor (like Wordpad or TextEdit). Changes to the CSS file will allow you to customize the fonts, colors, and layout of the various pages and items within your web gallery, and the changes you make will not be overwritten if you add more images to this gallery in a later Batch conversion. There is a brief description of the CSS selectors documented within the style .css file. Changes to index.html will, however, be overwritten during subsequent Batch Conversions.

The style of the gallery is determined by the "style" javascript variable in the index.html file, found towards the bottom of the file, that appears as:

```javascript
var style = 1;
```

You can change this to 1 for **Columns**, 2 for **Single Row**, or 3 for **Grid** styles. Editing other javascript items is discouraged and not supported.

**Copying images**

You can use the **Copy** settings in the **Make a Copy** or **Batch Export Settings** dialog box to make copies of the master files and associated sidecar files. You can save the files to the destination of your choice.

Why copy files? You can do any of the following:
• transfer photos from a memory card or other storage device
• archive
• back up files

You can also choose to import at the same time as you copy, saving you a step.

When you copy with a batch, all the master files that you select are copied as well as the sidecar files that contain data about any versions, edits, and metadata.

Some of settings for copying are the same as other batch settings. For more information, see “Understanding export settings” on page 146. The following settings are only in the page for the Copy tab.

**Output Name and Location** — same as the controls described in **Output Name** and **Location settings**, with the addition of:

- **Delete Original files** — deletes the image that you are copying after it has been copied successfully to the new location. All image files and associated sidecar files are copied to the location specified in the **Destination** section at the top of the dialog box.

**Import into Catalog** — enable this check box to import the images into a Corel AfterShot Pro catalog after the images are copied. The following importing options are available:

- **Import Location** — choose a catalog location
- **Prompt** — enable the check box if you want to see a dialog that asks for a catalog location when you first send images to this batch. It imports all images to the location you choose.
- **Select a folder** button — if you did not enable **Prompt**, you can click this button to choose a folder.
- **Keywords** — lets you add keywords that will be added to all the images as you import.
• **Apply Presets** — lets you apply presets to the images as you import them. For more information about presets, see “Working with Presets” on page 90.
Adjusting the workspace

This section explains how to optimize and control the main Corel AfterShot Pro window and the other visual aspects of Corel AfterShot Pro.

In this section, you’ll learn about

• Showing and hiding panels
• Viewing options
• Multi-Image View
• Resizing panels
• Magnifier
• Metadata viewer
Showing and hiding panels

The workspace and layout of the panels and screens in Corel AfterShot Pro let you adjust and configure your screen layout in many different ways. The following menu options and keyboard shortcuts will help you create a screen layout that is perfect for you.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Default shortcut key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>View &gt; Image View</td>
<td>F6</td>
<td>Switch to Image View, hiding the Thumbnail panel</td>
</tr>
<tr>
<td>View &gt; Standard View</td>
<td>F7</td>
<td>Switch to Standard View, revealing the Thumbnail panel and Preview panel</td>
</tr>
<tr>
<td>View &gt; Thumbnail View</td>
<td>F8</td>
<td>Switch to Thumbnail View, hiding the Preview panel</td>
</tr>
<tr>
<td>View &gt; Toggle Left Panel</td>
<td>L</td>
<td>Hide or show the Browse panel (left)</td>
</tr>
<tr>
<td>View &gt; Toggle Right Panel</td>
<td>R</td>
<td>Hide or show the Tools panel (right)</td>
</tr>
<tr>
<td>View &gt; Toggle Orientation</td>
<td>CTRL+L</td>
<td>Toggle from landscape mode (Preview panel above Thumbnail panel) to portrait mode (Preview panel right of Thumbnail panel)</td>
</tr>
<tr>
<td>View &gt; Full Screen</td>
<td>F11 (Win / Linux)</td>
<td>Toggle Full Screen mode</td>
</tr>
<tr>
<td></td>
<td>Command + F (Mac)</td>
<td></td>
</tr>
</tbody>
</table>

These modes and layout options are also available from the Top toolbar:
**Viewing options**

The Top toolbar lets you to switch between different window layouts and viewing modes. You can access the following viewing and layout options:

- **Slideshow slideshow** — lets you view a slideshow of the selected thumbnails.
- **Thumbnail View** — hides the Preview panel to allow quick browsing through many thumbnails.
- **Standard View** — reveals both the Preview panel and the Thumbnail panel.
- **Image View** — hides the Thumbnail panel to make the Preview panel as large as possible.
- **Magnifier magnifier** — lets you position your pointer over the preview window and magnify that image area.
- **Full Screen** — maximizes the application window and hides the title bar.

**Multi-Image View**

The Preview panel in Corel AfterShot Pro can show one or more selected versions. When **Multi-Image View** is enabled, up to six versions can be shown in the Preview panel. **Multi-Image View** is a great mode for comparing several versions from the same master versions, or you can compare multiple master versions that have similar content.
Note: When Multi-Image View is enabled, many operations that normally operate on all selected versions operate only on the active version, including functions like adding, deleting, and renaming versions, applying ratings, labels, and flags with the toolbar buttons or shortcut keys, and pasting of image settings.

To toggle Multi-Image View
• In the lower-right corner of the application window, click the Multi-Image View button.

Note: When using Multi-Image View, you can click the Lock Position and Zoom button (located beside the Multi-Image View button) to toggle the locking of the Pan position and Image Zoom level of multiple preview images.

Resizing panels
You can resize any of the panels. Resizing the Thumbnail panel to fit only one thumbnail in height (when in landscape mode) or one thumbnail in width (when in portrait mode) switches the Thumbnail panel from Thumbnail View to Standard View.
To resize a panel

- Position your pointer over the edge of the panel and drag when the resizing cursor appears.

**Magnifier**

The Magnifier displays a circular window that shows a 100% zoom view (default magnification) of any image or thumbnail under your mouse cursor. This is a great way to judge detail when adjusting sharpness or noise reduction or when you are viewing an image at less than 100% zoom.

The Magnifier was used to zoom in on the bee.

**To zoom into an area by using the Magnifier**

1. Do one of the following
   - Click the Magnifier button magnifier.
   - Press ‘ (located in the upper-left corner of the many keyboards).
2. Position your pointer over the area that you want to zoom into.
When finished, click the button or shortcut key again to hide the Magnifier.

To adjust the size and zoom level of the Magnifier

- In the menu bar, click View > Magnifier Sizing and choose an option from the submenu.
  
  Tip: You can also adjust the Magnifier by using any of the shortcut keys listed in the menu next to the sizing or zoom level command.

Metadata viewer

You can view key metadata in the Metadata pop-up window.

To open the Metadata pop-up window

- Press E and position your pointer over any thumbnail.
You can use Corel AfterShot Pro to create slideshows of your images.

In this section, you’ll learn about
• About slideshows
• Slideshow settings
• Playing a slideshow

### About slideshows

You can view slideshows of your images in Corel AfterShot Pro that can include metadata information about the images. The image can be viewed full screen.

### To open the Slideshow window

• In the upper-right corner of the application window, click the Slideshow button 🎥 slideshow.
Slideshow settings

When you open the Slideshow window, you'll see the following options.

**Playback**
- **Auto Advance** — progress to the next image after the selected duration.

**Layout**
- **Frame** — set the size and color of the frame shown around each image.
- **Background** — set the background color and set where the image is placed.
- **Show Guides** — show or hide guides in the Preview Slideshow. Full Screen slideshows always hide the guides.

**Title**
- **Title** — enable to show the Title; disable to hide the Title.
• **Position** — choose where the **Title** is shown.
• **Inset** — display the **Title** relative to the full Slideshow window (off) or relative to the image (on).
• **Font** — choose the font, size, and color for the **Title**.
• **Slideshow** — enter the text for the slideshow **Title**.

**EXIF**

• **EXIF** — enable to show the **Title**; disable to hide the **Title**.
• **Position** — choose where the **Title** is shown.
• **Inset** — display the **Title** relative to the full Slideshow window (off) or relative to the image (on).
• **Font** — choose the font, size, and color for the **Title**.
• **Metadata Chooser** — select which metadata to show for each image.

**Playing a slideshow**

You can preview a slideshow by auto-advances the preview image in the **Slideshow Setup** window, and lets you make adjustments to the slideshow settings. Playing a slideshow starts a full screen slideshow.
To preview a slideshow in the Slideshow window

- Click the image in the Slideshow window or uncheck the Full Screen check box at the bottom of the window and click Play. The slideshow plays, but all settings are accessible.

To play a full screen slideshow

- Double-click the image Slideshow window or enable the Full Screen check box at the bottom of the window and click Play.
  
If you want to pause the slideshow, click the image. To exit the slideshow, press Esc.
Printing

Corel AfterShot Pro allows you to print one or more images to any locally attached printer or a PDF file, and allows flexible layout control.

In this section, you’ll learn about
• Printing with Corel AfterShot Pro
• Printing a folder of images
• Print settings
• Controlling print jobs and page breaks
• Managing print batches
• Print layouts

Printing with Corel AfterShot Pro

Printing in Corel AfterShot Pro is handled with print batches. Each print batch is set to a specific layout type and includes other printing options. This allows you to setup printing once and quickly access those same settings later. This makes printing multiple images quick and easy.

Double-clicking a print batch in the Print section of the Output page in the Browse panel opens the Print Settings window.
To print selected images

1. Select one or more thumbnails in the Thumbnail panel.
2. Click the Output tab and do one of the following:
   - Drag the thumbnails to a batch name in the Printing section.
   - Double-click a batch name in the Printing section, set the options you want in Print Settings dialog box, and then drag the selected thumbnails to the dialog box.
   - If there is a shortcut key assigned to the batch you want to use (if set, shortcut keys appear to the left of the batch name), press the shortcut key.
Printing a folder of images

You can also print all the images in a folder that you select in the Browse panel (from the File System or Library).

To send a folder of images to a printing batch
1  In the Browse panel, right-click the folder you want to batch.
2  Select Send to print from the context menu, then the select name of the batch you want to use.

Print settings

Corel AfterShot Pro comes with several pre-defined print batches designed with several different layout options. You can edit or adjust these any way you want and you can create your own print batches.

Common Print Settings

Print batches in Corel AfterShot Pro share some controls, shown below.
Continuous Printing — With this check box enabled, Corel AfterShot Pro will send each page to the printer as soon as enough images have been added to the batch to fill at least one page. For more information, see “Controlling print jobs and page breaks” on page 172.

Page Settings — lets you choose your paper size, layout, and margins.

Printer Selection — sets the printer to use for this print batch.

Output DPI — specifies the DPI to use when sending images to the printer. A setting of 300 will produce high quality images, but some printers might benefit from settings as high as 600. Larger DPI will take longer to print, while smaller DPI will be faster, and will produce smaller files (if you are printing to a PDF).

Print to File — enable if you want to bypass your printer and print to a PDF file instead. Use the "..." box to specify a file name.

Controlling print jobs and page breaks

When a print layout contains more than one image on a page, such as a contact sheet, it is important to understand when printing will begin and how to control the page breaks. These operations are controlled by the Continuous Printing check box on the Print Settings panel.
Continuous Printing On

When Continuous Printing is enabled, Corel AfterShot Pro begins to process a print job as soon as enough images have been added to the print batch to fill a single page. As additional images are added to the batch, more pages are processed and sent to the printer (as pages fill up). If the page layout contains only one image, the images are sent to the printer immediately. If the print layout has multiple images on a single page, then the last page may not be auto-sent to the printer — it waits for the page to be filled. In order to print a partial page, you must open the Print Settings window and click Print in the lower right corner.

In Continuous Printing mode, to avoid wasting paper and ink, it is important to configure and confirm the following settings: Printer, Page Settings, Additional Image Settings, DPI, and Layout. This mode allows you to process a continuous stream of images as soon as they are added to a print batch. This is very useful for high-volume printing situations.

Continuous Printing Off

When Continuous Printing is not enabled, Corel AfterShot Pro queues all the images you send to the batch and does begin printing until you open the Print Settings window and click Print in the lower-right corner. This allows you to slowly choose all the images you want to print, review the pages to be printed, remove images or add additional images until you are satisfied with the image selection and print layout. When you are ready to send the images to the printer, click Print in the lower-right corner of the Print Settings window. This opens a dialog box with Printer Settings specific to the selected printer. This is where you set options like paper type, print quality, and printer color management options.
When you click **Print** and accept the settings in the **Printer Driver** window, all the images that are listed in the **Print Settings** window are processed and printed, including partial pages. If you add more images to the print batch, the new images do no print automatically; they remain queued until you click **Print** again.

This mode allows you to process batches of images together and includes a page break at the end of each batch with more than one image on a page.

**Managing print batches**

You can create new printing batches, duplicate a print batch, and delete a printing batch. You can also rename a print batch. Sometimes it is easier to duplicate an existing batch, and make modifications to this new copy, instead of making a new batch from scratch.

You can also assign a shortcut key to a printing batch. For example, **P** can be assigned to the **5x7 Qty. 2** batch, so at any time, you can simply press **P** to add the currently selected images to the **5x7 Qty. 2** printing batch in order to print the images quickly.

**To create a new print batch**

1. Click the **Output** tab.
2. Right-click a blank area of the **Printing** section, and choose **New** from the context menu.
3. In the **Print Settings** dialog box, choose the settings that you want to use for the batch.

After you create the batch, it appears in the **Printing** section list and the **Send selected files to print** context menu. You can rename the batch in the **Printing** section list.
To duplicate a print batch
1. Click the Output tab.
2. In the Printing section, right-click a batch name and choose Duplicate from the context menu.

To delete a print batch
1. Click the Output tab.
2. In the Printing section, right-click a batch name and choose Delete from the context menu.

To rename a print batch
1. Click the Output tab.
2. Right-click a name in the Printing section, and choose Rename from the context menu.
3. Type a new name for the print batch.
   Tip: You can also double-click (slowly) a batch name in the Printing section, type a new name, and press Enter when finished.

To assign a shortcut key to a batch
1. Click the Output tab.
2. Right-click a batch name in the Printing section, and choose Set shortcut from the context menu.
3. Press the key or key combination that you want to use for a shortcut. The shortcut appears in the Set shortcut dialog box.

Print layouts

Each Print Batch has one Print Layout, that defines where the images and optional image captions are placed on the page. These places where the images will appear on paper are called Cells. There are four
Print Layout options, which control where the cells will appear, how large each cell is, spacing between cells, and other layout options.

Many of these Layouts include the following options:

4 **Best fit** — enable to automatically rotate images 90 degrees if the rotation results in a larger image. When this not enabled, images are printed in the normal orientation set for each image.

5 **Scale crop** — crops the image to fill the cell with as much of the image as possible. This results in no white space inside each cell.

6 **Scale reduce** — shrinks the image so that no part of the image is cropped, ensuring that your whole picture is printed.

**Contact Sheet**

A **Contact Sheet** layout fills a page with a configurable number of columns and rows of images. The **Spacing** setting controls the gap that is placed between adjacent cells.

A caption appears next to each cell. By default, the caption will be the full, original filename of the image being printed, and will be located below the image cell. The **Size** control sets the size of the **Caption** cell, and the **Font Size** control sets the point size of the font used to print the caption. Use any renaming formats as part of the caption text.

The contact sheet shown above would look like this:
**Fixed Size**

Fixed Size layouts place cells of a specific size — chosen with the drop-down menu or entered into the two text boxes below the drop-down menu. Corel AfterShot Pro will automatically configure the page layout to fix as many cells on a page as possible. **One image per page** tells Corel AfterShot Pro to fill each page with a single image; with this unchecked, Corel AfterShot Pro will place one image in each cell. 'Pictures per page' can be set to limit Corel AfterShot Pro to only put a specific number of images on a page; 'Max' tells Corel AfterShot Pro to fill the page with as many cells of the specified size as possible.

After you change the paper size, the number of images that fit on a page and their placement on the page also changes. It is possible to
select a cell size larger than your paper size, in which case the image will not print.

The Fixed Size layout shown above would look like this:

![Fixed Size layout](image)

**N-Up**

The N-Up layout allows you to specify how many images to print on a page, in rows and columns, with the designated amount of spacing between cells.

![N-Up layout](image)

For example:
**Custom Layouts**

The **Custom** layout style is the most complicated, but also the most flexible. The layout is controlled by text files that reside in the layout folder inside your **Corel AfterShot Pro Settings** folder. For more information, see “Custom print layouts” on page 209.

There are two custom layouts that are provided with Corel AfterShot Pro, which result in layouts like these:
Application preferences

You can set a range of application preferences, some are very general and others apply to specific tools or controls. For example, you can set display, color management, and cache preferences. You can also set keyboard shortcuts, and determine how some tools work, such as the Crop tool.

In this section, you’ll learn about
- Accessing preferences
- General preferences
- Display preferences
- Color Management preferences
- Import and Cache preferences
- Renaming preferences
- Sequence preferences
- Keyboard preferences
- Soft Proofing preferences
- Copy Sets preferences
- Defaults preferences
- Crop preferences
- External Editor preferences
- Performance preferences
- Hardware Acceleration preferences
Accessing preferences

The Preferences dialog box lets you access the preference settings. A list on the left side of the dialog box lets you choose a category and display a page with the corresponding settings.

To access application preferences

• Click File > Preferences.

General preferences

This Preferences page allows you to view and edit general preferences for Corel AfterShot Pro.

• Language — choose the language for display in Corel AfterShot Pro. You must restart the application for this to take full effect.

• User Folder Location — set your user folder to a different location. Changing this location does not move your current user folder to the new location. If you would like to change user folder locations while preserving your current settings, cache, and other preferences, then you should:
  1 Run Corel AfterShot Pro, and change the User Folder Location in the preferences.
  2 Close Corel AfterShot Pro.
  3 Manually move your current user folder to the location that you set in the preferences.
  4 Restart Corel AfterShot Pro and verify that your previous preferences, settings, and cache are intact and found by Corel AfterShot Pro.

• Default Catalog Location — choose what folders new catalogs should be created in. Changing this does not move current catalogs.
• **Default sample size for tools** — set the number of pixels the White Balance tool uses when sampling from your image.

• **Allow automatic AfterShot .xmp creation for photos in Catalogs** — when checked, all adjustments to images imported into a Corel AfterShot Pro catalog will be written both to a Corel AfterShot Pro catalog and to Corel AfterShot Pro .xmp sidecar files.

• **Allow AfterShot to check for program updates on startup** — lets Corel AfterShot Pro access the Internet to look for an updated version of Corel AfterShot Pro. No personal information is transmitted to Corel during the update notification process.

• **Open collapsed panels by positioning the pointer over them** — reveals the Browse panel or Tools panel when you position your pointer over the panel area. Disable this option to require a click to reveal these panels.

• **Delay pointer action** — wait this amount of time before revealing the panels

• **Re-enable all warning dialogs** — all warning dialogs in Corel AfterShot Pro offer the option to prevent that same warning dialog from appearing. This button resets all the warnings so that all future warning dialogs will be shown again.

• **Reset default files** — many settings such as output batches, print layouts, presets, and other settings are stored as files in your Corel AfterShot Pro Settings home folder. Press this button to re-copy the default settings files to your home folder. New batches, presets and other settings stored as files will not be edited or removed.

**Display preferences**

This Preferences page allows you to view and edit display preferences.
• **Background Preview Panel** — sets the color for the background of the Preview panel. Requires restart to take effect.

• **Shadow Warning** — sets the shadow and highlight warning level. Values below the **Shadow Warning** level and above the **Highlight Warning** level will be highlighted when **Clipping Warning** is enabled.

• **Maximum number of images in Multi-Image View** — controls how many images will be shown at any one time in **Multi-Image View**.

• **EXIF Viewer uses Metadata Set** — lets you choose which metadata set you want to show in the metadata pop-up window.

• **Display formats for dates** — sets a default date format for the application.

• **Metadata viewer updates on mouse over** — resets the viewer each time you position your pointer over another image.

• **Use round shape for Magnifier (uncheck for rectangle)** — use a round (enabled) or rectangular (disabled) magnifier. Switch to a rectangle for a slightly larger magnifier, and to prevent display issues on Linux systems when desktop compositing is disabled.

• **Highlight Alternating Rows** — in list views, like the **Catalog section** and **Metadata Browser section** of the Browse panel, highlight alternating rows. Disable for uniform row colors. Requires restart to take effect.

• **Use smaller fonts and icons** — Enable this on notebooks and netbooks to make workspace elements smaller. Requires restart to take effect.

• **Maintain zoom when switching images** — lets you pan and zoom into a single image, and then keep that zoom and pan position when switching images. This only affects Single Image view.
• **Use animation for image zoom** — enables animation when zooming in or out on images. Disable this on slower computers for quicker viewing.

• **Show only high quality previews** — enabling this preference will prevent Corel AfterShot Pro from showing lower quality previews when making image adjustments — which can make the previewing process take slightly longer.

### Color Management preferences

This Preferences page allows you to view and edit color management preferences.

• **Monitor Profile** — select your monitor's profile. Click Reset if you re-calibrate your monitor and Corel AfterShot Pro does not auto-detect the change. (Corel AfterShot Pro should auto-detect the correct profile on Windows and Mac computers).

• **Default JPEG Profile** — when importing JPEG images that do not contain a color profile, use this profile as the input profile.

• **Default TIFF Profile** — when importing TIFF images that do not contain a color profile, use this profile as the input profile.

### Import and Cache preferences

This Preferences page allows you to view and edit Importing and Cache preferences.

When working in File System mode and other operations, Corel AfterShot Pro creates cached thumbnails and previews and stores cached copies of image settings for folders that you have browsed to. These files allow faster browsing and operations within File System mode, but can grow to be quite large over time. Corel AfterShot Pro allows you to control how much data to cache, and when to reduce the cache.
Reducing cache size only happens when Corel AfterShot Pro first launches, so the cache can grow beyond the specified size during normal usage.

- **Create Previews during Importing and File System Browsing** — create thumbnail and preview images for all images imported or that are being browsed in File System mode. Previews allow a quicker display of your images and allow viewing images in Catalogs that are off-line. Some image files do not contain embedded thumbnails or previews (which are used in place of Corel AfterShot Pro-generated thumbnails and previews) and with this option disabled, no thumbnail image can be displayed until a Preview is created for that image.

- **Check Cache Size every** — controls how often Corel AfterShot Pro should examine the cache size to determine if it should be reduced.

- **Remove cached items not viewed in the last** — controls how long to preserve image data in the cache. Set this to zero to disable removing items based on age. Items will only be removed when the cache size grows larger than the Target Cache Size.

- **Target Cache Size** — remove items (oldest first) until the cache fits within this specified size.

### Renaming preferences

This Preferences page allows you to view and edit Renaming Formats.

Renaming formats are a simple way to apply flexible renaming schemes. You can create new formats using any of the renaming formats that Corel AfterShot Pro supports. These renaming formats are used in the Export and Batch Export Settings dialog box and when renaming versions (Version > Rename Version).

- **New format** — opens a dialog where you can create new renaming formats.
• **Remove Current** — removed the current, highlighted format from the list.

**To edit existing renaming formats**
- Double-click the right column in the list and adjust the renaming format.

**Sequence preferences**

This Preferences page allows you to view and edit Renaming Sequence parameters.

Rename Sequence parameters allows Corel AfterShot Pro to sequentially number your images while remembering the last number used for specific sequences. Each Jobname can use a unique sequence, or you can use overall sequences like the `[seq]` renaming variable. The Value column on this preferences panel shows what number the next use of each sequence will use. You can double-click the Value cell to change the next sequence number.
- **Remove Current** — removes the current, highlighted sequence from the list.

**Keyboard preferences**

This Preferences page allows you to view and edit any of the keyboard shortcuts.

**To set or change a shortcut**

1. Click in the **Shortcut** column next to the **Action** you want to edit.
2. Press the key or key combinations you want to assign to that action.
3. Click anywhere outside the row to apply your new keyboard shortcut.
**Note:** Corel AfterShot Pro will warn you if you try to assign a shortcut that is currently being used by another Action. You may choose to Replace the shortcut, which will remove the shortcut from the previous action and will set the shortcut you've chosen, or you may cancel, keeping the previous settings.

**Soft Proofing preferences**

This Preferences page allows you to view and edit the list of color profiles that can be selected in the Soft Proofing menu option and toolbar controls.

This page contains the following controls:

- **Add Profile** — opens a file selection dialog to allow you to select additional icc or icm color profiles.
- **Remove Current** — removes the current, highlighted profile from the list.

**Copy Sets preferences**

This Preferences page allows you to view, create and edit copy sets.

**Copy Sets** lets you assign shortcut keys that copy specific settings from the selected image. For example, pressing Ctrl+1 copies all metadata, and IPTC information from the selected image. Then you can select several other images and press Ctrl+V to paste these settings. This page contains the following controls:

- **Add New** — opens the Selective Copy dialog box so you can choose the settings you want to copy
- **Edit Current** — opens the Selective Copy dialog box so you can edit the settings.
- **Remove Current** — removes the current, highlighted copy set from the list.
Defaults preferences

This Preferences page allows you to view or remove custom default settings used when new images are imported or browsed to in Corel AfterShot Pro.

Custom Default Settings allow you to adjust the initial settings Corel AfterShot Pro applies to new images that it encounters. See the section on creating custom defaults for additional information. This page contains the following controls:

- **View Current** — opens the Selective Copy dialog box.
- **Reset Current** — resets the standard DefaultRAW or DefaultRendered settings to their original default settings. This is visible only when the RAW or Rendered default is selected.

Crop preferences

This Preferences page allows you to view, add or remove custom crop settings.

- **Opacity of cropped-out area** — sets how dark the removed portion of the image will be shown when the cropping tool is enabled.
- **Grid sections** — sets the number of lines or sections to show in the crop window. Setting this to 3 will create "rule-of-thirds" lines to help visualize your crop, and setting it to 2 will show grid lines through the center of the crop frame.
- **Show frame** — lets you set when to show the crop frame: Always, Never, or only when Dragging the crop window.
- **Show grid** — lets you set when to show the grid: Always, Never, or only when Dragging the crop window.
- **Show Crop dimensions** — lets you hide or display the size and location of the crop in pixels within the crop window.
• **Add New** — opens the **Crop Size** dialog box so you can create new settings for a crop preset.

• **Edit Current** — opens the **Crop Size** dialog box so you can edit or rename crop preset settings.

• **Remove Current** — removes the current, highlighted crop preset from the list.

**External Editor preferences**

You can choose an external editor that you want to access from Corel AfterShot Pro. For more information about accessing the external editor, see “Editing photos in an external image editor” on page 98.

**To change the external editor settings**

1. Click **File > Preferences**, and click **External Editor**.

2. Set the **Editor**, **File Format**, dpi, and **Color Space** settings you want.

   **Tip:** You can remove external editors from the **Editor** list by clicking the **Remove Editor** button 🚩. If you remove all editors in the list, the **Edit in the External Editor** button on the top toolbar resets to its default state.

**Performance preferences**

The **Performance** preferences let you adjust various performance-related settings for Corel AfterShot Pro. The default values should be optimal for the vast majority of users—changing these settings can very easily degrade performance or cause instability. Only the default parameters are tested. Use these settings at your own risk.

**Hardware Acceleration preferences**

The **Hardware Acceleration** page lets you access OpenCL settings. OpenCL lets you use graphics card computing resources (GPU) to help
boost the overall processing speed of the application. To use OpenCL, you must have a compatible graphics card running the latest driver from the manufacturer's website. The benefit is most noticeable when you output your images. The results depend on your graphics card, your system, and the OpenCL Utilization setting that you choose.

The Hardware Acceleration preferences page contains the following controls:

- **Use OpenCL** — lets you activate OpenCL. Select the check box to use OpenCL; clear the check box to turn off OpenCL.
- **Platform** — lists the graphics card software. Choose the software you want to use.
- **Graphics Cards** — lets you choose which graphics card you want to use if you have more than one installed.
- **OpenCL Utilization** — provides four settings: **Minimum**, for systems with lower-end GPUs but higher-end CPU processing capabilities; **Low**, for systems with lower processing capabilities; **Standard**, for average systems; and **High**, for high-performance systems.

**Testing OpenCL performance on your system**

There are many factors that determine the processing speed when you use OpenCL, including which OpenCL Utilization setting you use. To find out which setting is best for your system, you can run a speed test. Basic test instructions are outlined on the Hardware Acceleration preferences page.
To gauge speed, you can view total processing time and average time per image after the processing is complete.
Renaming formats

Corel AfterShot Pro includes powerful renaming formats for photos. You can use renaming formats, also called renaming variables, to generate descriptive names for your photos. The photo name can include dates, times, image data, job sequence data, and other information.

There are four categories of renaming formats:

- **Date/Time** — specifies variables that use the date and time data from your camera.
- **EXIF** — specifies tags that use shooting data applied to the raw image from the camera.
- **Original File** — specifies tags that use the original image naming data applied to the image by the camera.
• **Special/Sequences** — specifies custom job naming and image numbering tags that can be based on user input at the time the image is processed.

### Basic Naming Formats

A basic renaming format might include the original name that was applied to the photos by the camera. For example, one default renaming formats looks like this:

```
[oname][ext]
```

- `[oname]` — represents the original file name (from the camera)
- `[ext]` — applies the file extension for the file type you want to output to. For example, if you are outputting JPEGs, this variable applies a `.jpg` extension to the file name.

In addition, you can use constants to add information to the name. For example, a renaming format that uses constants might look like this:

```
MyPics[oname][ext]
```

In this case, the prefix "MyPics" is added to the beginning of each image name. While adding information to a renaming format in this way can be helpful, Corel AfterShot Pro provides more powerful ways to apply specific names to processed images.

### Job Name and Numbering Sequences

The job sequence renaming variables let you specify a job name and a counting sequence associated with a particular job. Since the value of the job name variable is input by you as you process images, it is possible to use one Output Batch to process images for several jobs simultaneously. For example, suppose you are processing images for the following two jobs: SmithWedding and JonesWedding. You can use these renaming variables to process images for both jobs:
In this case, the [jobname] variable prompts you for a job name. If you are processing images from the Smith wedding, when Corel AfterShot Pro prompts you for a job name, you can enter SmithWedding, and the image processes using that name. The [jobseq] number is a counter that counts the processed images associated with the job name. The counter starts at 0. So, the name of the first image processed for the Smith wedding job will look like this:

SmithWedding-0.jpg

The name of the second processed image for the Smith wedding will look like this:

SmithWedding-1.jpg

Using the same batch queue, you can also process images from the Jones wedding. When Corel AfterShot Pro prompts you for a job name, you can enter JonesWedding, and the image processes using that job name. The [jobseq] variable checks the number of images processed under this job name and starts the counting sequence accordingly. The name of the first image processed for this job name looks like this:

JonesWedding-0.jpg

Corel AfterShot Pro lets you specify a padding constant when using renaming formats. For example, if you wanted the sequence number to be a certain length, you can add a constant to the rename variable to specify the amount of padding needed. For example, suppose you want the numbering for the Smith and Jones wedding images to be 4 places long. When you add a padding value to a renaming variable, the renaming format looks like this:

[jobname-][4jobseq][ext]
In this case, the [4jobseq] variable will generate sequence numbers that are four characters long. For example, using this job sequence definition, the name of the next images processed for the Jones wedding look like this:

JonesWedding-0001.jpg, JonesWedding-0002.jpg, JonesWedding-0003.jpg ...

Note: The placement of the padding value determines where the extra characters are placed. When the padding value is placed before the variable, the additional characters are placed before the rename value. If the padding value is placed after the variable name, the additional characters are placed after the rename value.

Rename Case Conversion

You can instruct Corel AfterShot Pro to force rename variables to be either all lower case, all upper case, or leave the case in it's original form. Use "<" before the variable name to force lower case, and ">" before the variable name to force upper case. For example, the [model] variable for Canon's 20D digital SLR is "Canon EOS 20D"; using [model] in the formats below:

[model] results in: Canon EOS 7D
[>model] results in: CANON EOS 7D
[<model] results in: canon eos 7d

And you can combine this rename formatting with the padding constant discussed above:

[model3] results in: 7D
[>5model] results in: CANON
Persistent Sequence Numbering

Corel AfterShot Pro's renaming formats include a persistent sequence variable that enables you to track the number of images processed by Corel AfterShot Pro. This variable counts all processed images in order, and saves the number when you quit Corel AfterShot Pro. This variable ensures that a unique sequence number is applied to each processed image. For example, the following renaming format uses the persistent sequence variable to append a unique sequence number to the processed image:

[jobname][seq][ext]

In this case, the [seq] variable looks up the saved persistent sequence number saved by Corel AfterShot Pro and adds to it when processing the image.

Renaming variables

You can include the rename variables below as part of a batch destination folder. For example, selecting 'Relative' as the destination type and entering "[queuename]" as the path will create a new folder under the RAW file's location with the name of the queue used to create the output images.

Reference tables of renaming variables

Sequence

<table>
<thead>
<tr>
<th>Rename Item</th>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job name</td>
<td>[jobname]</td>
<td>The job name entered by the user</td>
</tr>
<tr>
<td>Job sequence</td>
<td>[jobseq]</td>
<td>The number of items processed under the job name</td>
</tr>
</tbody>
</table>
### Rename Item Variables

<table>
<thead>
<tr>
<th>Rename Item</th>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Queue name</td>
<td>[queueuname]</td>
<td>The name of the batch queue</td>
</tr>
<tr>
<td>Batch Queue sequence</td>
<td>[queueq]</td>
<td>The number of items processed by the batch queue</td>
</tr>
<tr>
<td>Persistent sequence</td>
<td>[seq]</td>
<td>The total number of files processed by Corel AfterShot Pro</td>
</tr>
<tr>
<td>Rename sequence</td>
<td>[rseq]</td>
<td>The number for images being renamed using the Context Menu Rename function</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Right-click &gt; Rename)</td>
</tr>
<tr>
<td>Suggested extension</td>
<td>[ext]</td>
<td>The suggested file extension for the file output type</td>
</tr>
</tbody>
</table>

### Original File Items

<table>
<thead>
<tr>
<th>Rename Item</th>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full filename</td>
<td>[ofullname]</td>
<td>The full name of the original file</td>
</tr>
<tr>
<td>Filename</td>
<td>[oname]</td>
<td>The name of the original file with the extension removed</td>
</tr>
<tr>
<td>Rename Item</td>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Version Name</td>
<td>[vname]</td>
<td>The name of the version within Corel AfterShot Pro. This defaults to the master file name plus the revision number. For example, a second version of the master file IMG_1234.CR2 would have an [vname] of IMG_1234-2</td>
</tr>
<tr>
<td>Extension</td>
<td>[oext]</td>
<td>The extension of the original file</td>
</tr>
<tr>
<td>File Number</td>
<td>[onum]</td>
<td>The file number of the original file. For example, the RAW file IMG_1234.CR2 would have an [onum] of 1234</td>
</tr>
<tr>
<td>Master File Path</td>
<td>[opath]</td>
<td>Full original folder path for the master file</td>
</tr>
</tbody>
</table>
### Rename Item Variable Description

<table>
<thead>
<tr>
<th>Rename Item</th>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Folder from the Master File location</td>
<td>[opath-N]</td>
<td>Single folder found at N folders deep from the master file. For example, if a master file is at C:\Users\Jeff\Pictures\My Photos, then [opath-1] would be &quot;My Photos&quot; and [opath-2] would be &quot;Pictures&quot;</td>
</tr>
</tbody>
</table>

### Metadata Items

<table>
<thead>
<tr>
<th>Rename Item</th>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rating</td>
<td>[rating]</td>
<td>The number of stars assigned to the selected Version</td>
</tr>
<tr>
<td>Label</td>
<td>[label]</td>
<td>The Color Label assigned to the selected Version</td>
</tr>
<tr>
<td>Flag</td>
<td>[flag]</td>
<td>The Flag state of the selected Version</td>
</tr>
</tbody>
</table>

### Date & Time Items

<table>
<thead>
<tr>
<th>Rename Item</th>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>[date]</td>
<td>The year, month, and day the image was exposed. Format: yyyy_mm_dd</td>
</tr>
<tr>
<td>Rename Item</td>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Year</td>
<td>[year]</td>
<td>The year during which the image was exposed</td>
</tr>
<tr>
<td>Month</td>
<td>[month]</td>
<td>The month during which the image was exposed</td>
</tr>
<tr>
<td>Day</td>
<td>[day]</td>
<td>The day on which the image was exposed</td>
</tr>
<tr>
<td>Time</td>
<td>[time]</td>
<td>The hour, minute, and second the image was exposed. Format: hh_mm_ss</td>
</tr>
<tr>
<td>Hour</td>
<td>[hour]</td>
<td>The hour during which the image was exposed</td>
</tr>
<tr>
<td>Minute</td>
<td>[minute]</td>
<td>The minute during which the image was exposed</td>
</tr>
<tr>
<td>Second</td>
<td>[second]</td>
<td>The second during which the image was exposed</td>
</tr>
<tr>
<td>Subsecond</td>
<td>[subsec]</td>
<td>The sub-second during which the image was exposed</td>
</tr>
<tr>
<td>Day name</td>
<td>[dayname]</td>
<td>Example: Monday, Tuesday</td>
</tr>
<tr>
<td>Short Day name</td>
<td>[dayshort]</td>
<td>Example: Mon, Tue</td>
</tr>
<tr>
<td>Month name</td>
<td>[monthname]</td>
<td>Example: January, February</td>
</tr>
<tr>
<td>Short Month name</td>
<td>[monthshort]</td>
<td>Example: Jan, Feb</td>
</tr>
</tbody>
</table>
## EXIF Data Items

<table>
<thead>
<tr>
<th>Rename Item</th>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO</td>
<td>[iso]</td>
<td>ISO setting</td>
</tr>
<tr>
<td>Lens</td>
<td>[lens]</td>
<td>Lens</td>
</tr>
<tr>
<td>Camera Make</td>
<td>[make]</td>
<td>Camera Make</td>
</tr>
<tr>
<td>Camera Model</td>
<td>[model]</td>
<td>Camera Model</td>
</tr>
<tr>
<td>Width</td>
<td>[width]</td>
<td>Width (in pixels) of original image</td>
</tr>
<tr>
<td>Length</td>
<td>[length]</td>
<td>Length (in pixels) of original image</td>
</tr>
<tr>
<td>F-number</td>
<td>[fnumber]</td>
<td>Aperture</td>
</tr>
<tr>
<td>Software</td>
<td>[software]</td>
<td>Software used to convert image</td>
</tr>
<tr>
<td>Exposure</td>
<td>[exposure]</td>
<td>Exposure (shutter speed) expressed as a decimal</td>
</tr>
<tr>
<td>Copyright</td>
<td>[copyright]</td>
<td>Copyright notification</td>
</tr>
<tr>
<td>Usage Terms</td>
<td>[usageterms]</td>
<td>Usage Terms</td>
</tr>
</tbody>
</table>
### IPTC Data Items

<table>
<thead>
<tr>
<th>Rename Item</th>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Name</td>
<td>[imagename]</td>
<td>IPTC image name</td>
</tr>
<tr>
<td>Priority</td>
<td>[priority]</td>
<td>IPTC image priority</td>
</tr>
<tr>
<td>Category</td>
<td>[category]</td>
<td>IPTC image category</td>
</tr>
<tr>
<td>Byline</td>
<td>[byline]</td>
<td>IPTC image byline</td>
</tr>
<tr>
<td>Byline Title</td>
<td>[bylinetitle]</td>
<td>IPTC image byline title</td>
</tr>
<tr>
<td>Caption</td>
<td>[caption]</td>
<td>IPTC image caption</td>
</tr>
<tr>
<td>City</td>
<td>[city]</td>
<td>IPTC image City</td>
</tr>
<tr>
<td>State</td>
<td>[state]</td>
<td>IPTC image State</td>
</tr>
<tr>
<td>Headline</td>
<td>[headline]</td>
<td>IPTC image Headline</td>
</tr>
<tr>
<td>Title</td>
<td>[title]</td>
<td>IPTC Image Title</td>
</tr>
<tr>
<td>Job ID</td>
<td>[jobid]</td>
<td>IPTC Job Identifier</td>
</tr>
</tbody>
</table>
IPTC Creator Items

<table>
<thead>
<tr>
<th>Rename Item</th>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creator's Address</td>
<td>[creatoraddresss]</td>
<td>Street Address</td>
</tr>
<tr>
<td>Creator's City</td>
<td>[creatorcity]</td>
<td>City</td>
</tr>
<tr>
<td>Creator's Region or State</td>
<td>[creatorregion]</td>
<td>Region or State</td>
</tr>
<tr>
<td>Creator's Postal Code</td>
<td>[creatorpostalcode]</td>
<td>Postal Code</td>
</tr>
<tr>
<td>Creator's Country</td>
<td>[creatorcountry]</td>
<td>Country</td>
</tr>
<tr>
<td>Creator's email</td>
<td>[creatoremail]</td>
<td>email address</td>
</tr>
<tr>
<td>Creator's phone number</td>
<td>[creatorphone]</td>
<td>phone number</td>
</tr>
<tr>
<td>Creator's website address</td>
<td>[creatorwww]</td>
<td>website address</td>
</tr>
</tbody>
</table>

Metadata tags

The table below shows how metadata in Corel AfterShot Pro corresponds to metadata from various other sources.

When importing metadata from XMP files, Corel AfterShot Pro combines keywords and hierarchical keywords into a single list of keywords, preserving any hierarchy. Corel AfterShot Pro outputs keywords in a similar way, preserving both hierarchical and flat keyword structures.

<table>
<thead>
<tr>
<th>IPTC Core</th>
<th>Corel AfterShot Pro</th>
<th>XMP Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title</td>
<td>dc:title</td>
</tr>
<tr>
<td>Priority</td>
<td></td>
<td>photoshop:Urgency</td>
</tr>
<tr>
<td>Category</td>
<td></td>
<td>photoshop:Category</td>
</tr>
<tr>
<td>IPTC Core</td>
<td>Corel AfterShot Pro</td>
<td>XMP Path</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Sup. Categories</td>
<td>SupplemenentalCategories</td>
<td>photoshop:SupplementalCategories</td>
</tr>
<tr>
<td>Keywords</td>
<td>Keywords</td>
<td>dc:subject lr:HierarchicalKeywords</td>
</tr>
<tr>
<td>Instructions</td>
<td>Instructions</td>
<td>photoshop:Instructions</td>
</tr>
<tr>
<td>Date Created</td>
<td>Date</td>
<td>photoshop:DateCreated</td>
</tr>
<tr>
<td>Creator</td>
<td>Creator</td>
<td>dc:creator</td>
</tr>
<tr>
<td>Creator's Job Title</td>
<td>Author's Position</td>
<td>photoshop:AuthorsPosition</td>
</tr>
<tr>
<td>City</td>
<td>City</td>
<td>photoshop:City</td>
</tr>
<tr>
<td>State / Province</td>
<td>State</td>
<td>photoshop:State</td>
</tr>
<tr>
<td>Country</td>
<td>Country</td>
<td>photoshop:Country</td>
</tr>
<tr>
<td>Job Identifier</td>
<td>Job Id</td>
<td>photoshop:TransmissionReference</td>
</tr>
<tr>
<td>Headline</td>
<td>Headline</td>
<td>photoshop:Headline</td>
</tr>
<tr>
<td>Provider</td>
<td>Credit</td>
<td>photoshop:Credit</td>
</tr>
<tr>
<td>Source</td>
<td>Source</td>
<td>photoshop:Source</td>
</tr>
<tr>
<td>Copyright Notice</td>
<td>Copyright</td>
<td>dc:rights</td>
</tr>
<tr>
<td>Caption / Abstract</td>
<td>Caption</td>
<td>dc:description</td>
</tr>
<tr>
<td>Caption Writer</td>
<td>Caption Writer</td>
<td>photoshop:CaptionWriter</td>
</tr>
<tr>
<td>IPTC Core</td>
<td>Corel AfterShot Pro</td>
<td>XMP Path</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Creators Contact Info</td>
<td>Creator's City</td>
<td>Iptc4xmpCore:CiAdrCity</td>
</tr>
<tr>
<td>City</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creators Contact Info</td>
<td>Creator's Country</td>
<td>Iptc4xmpCore:CiAdrCity</td>
</tr>
<tr>
<td>Country</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creators Contact Info</td>
<td>Creator's Address</td>
<td>Iptc4xmpCore:CiAdrExtadr</td>
</tr>
<tr>
<td>Address</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creators Contact Info</td>
<td>Creator's Postal Code</td>
<td>Iptc4xmpCore:CiAdrPostalCode</td>
</tr>
<tr>
<td>Postal Code</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creators Contact Info</td>
<td>Creator's State</td>
<td>Iptc4xmpCore:CiAdrRegion</td>
</tr>
<tr>
<td>State</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creators Contact Info</td>
<td>Creator's Email</td>
<td>Iptc4xmpCore:CiEmailWork</td>
</tr>
<tr>
<td>Email(s)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creators Contact Info</td>
<td>Creator's Phone</td>
<td>Iptc4xmpCore:CiTelWork</td>
</tr>
<tr>
<td>Phone(s)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>Location</td>
<td>Iptc4xmpCore:Location</td>
</tr>
<tr>
<td>Rights Usage Terms</td>
<td>Usage Terms</td>
<td>xmpRights:UsageTerms</td>
</tr>
<tr>
<td>Subject Code</td>
<td>Subject Code</td>
<td>Iptc4xmpCore:SubjectCode</td>
</tr>
<tr>
<td>IPTC Scene</td>
<td>Scene</td>
<td>Iptc4xmpCore:Scene</td>
</tr>
<tr>
<td>Intellectual Genre</td>
<td>Intellectual Genre</td>
<td>Iptc4xmpCore:IntellectualGenre</td>
</tr>
<tr>
<td>Rating</td>
<td></td>
<td>xap:Rating</td>
</tr>
<tr>
<td>Label</td>
<td></td>
<td>xap:Label</td>
</tr>
</tbody>
</table>

**File locations**

When you first run Corel AfterShot Pro, it will ask where to store your **Corel AfterShot Pro Settings Folder** and a **Corel AfterShot Pro**
Catalog Location. The Corel AfterShot Pro Settings Folder contains settings, saved presets, cached data about images and folders, and other preferences and options needed to run Corel AfterShot Pro. The default location for the Corel AfterShot Pro Settings Folder is different on various operating systems, so check the details below for the system you are running. Within the Settings Folder are sub-folders that contain batches and presets, which are stored as plain text files. You may copy these batches and presets from one computer to another to share these across multiple work locations (like your notebook and your studio) or with friends or colleagues.

The Corel AfterShot Pro Catalog Location is where new Corel AfterShot Pro catalogs are stored. Corel AfterShot Pro catalogs are only used if you import images into a catalog. For information about importing, see “Importing images” on page 37. If you do use catalogs in Corel AfterShot Pro, this folder can grow quite large, and is accessed frequently, so choose a folder on a fast, locally-attached disk with plenty of free space for best performance. You can create new catalogs in other locations, so not all catalogs need to be on the same disk.

Windows

The default locations for various components for Windows are shown below; [username] is a placeholder that represents your Windows username.

<table>
<thead>
<tr>
<th>Item</th>
<th>Default Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Location (64-bit OS)</td>
<td>C:\Program Files\Corel\Corel\AfterShot Pro 3</td>
</tr>
<tr>
<td>Settings Folder (Windows 7, Windows 8, Windows 10)</td>
<td>C:\Users[username]\AppData\Local\Corel\AfterShot Pro 3</td>
</tr>
<tr>
<td>Catalog Location (Windows 7, Windows 8, Windows 10)</td>
<td>C:\Users[username]\My Pictures\AfterShot Pro Catalogs</td>
</tr>
</tbody>
</table>
**Mac**

The default locations for various components for OS are shown below; ~ is a placeholder that represents your Mac OS home folder.

<table>
<thead>
<tr>
<th>Item</th>
<th>Default Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Location</td>
<td>Applications folder</td>
</tr>
<tr>
<td>Settings Folder</td>
<td>~/Library/Application Support/Corel AfterShot Pro 3</td>
</tr>
<tr>
<td>Catalog Location</td>
<td>~/Pictures/Corel AfterShot Pro</td>
</tr>
</tbody>
</table>

**Linux**

The default locations for various components for Linux are shown below; ~ is a placeholder that represents your Linux home folder.

<table>
<thead>
<tr>
<th>Item</th>
<th>Default Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Location</td>
<td>/opt/Corel AfterShot Pro</td>
</tr>
<tr>
<td>Settings Folder</td>
<td>~/.AfterShot Pro 3 [Note: “.” designates a hidden folder]</td>
</tr>
<tr>
<td>Catalog Location</td>
<td>~/Pictures/Corel AfterShot Pro</td>
</tr>
</tbody>
</table>

**Command line options**

Corel AfterShot Pro can open image files and queue files that are dropped onto the Corel AfterShot Pro application icon or that are passed in on the command line, or that are opened with the **File** > **Open** command. The files will be opened in **File System** mode, meaning that image settings and metadata will be read from XMP and Corel AfterShot Pro XMP files that reside with the images being opened — and not any settings found in Corel AfterShot Pro catalogs that contain those files.
Work Queue files are plain text files that list the files to be opened in Corel AfterShot Pro. They are simple files, made up of the following parts:

- **First Line**: [Work Queue Name]
- **Second Line**: ignored
- **All following lines**: Fully qualified paths of the images to be opened

### Custom print layouts

Custom print layouts let you arrange many sizes of image cells on a single page. Custom layouts are saved as plain text files in the layouts folder found in your Corel AfterShot Pro Settings Folder. These text files have the following settings:

The top of the file specifies the name of this layout:

```
[layout]
name       =demo1
```

After this, a section like the one below appears for every image cell or caption cell:

```
[cell1]
type       =image
image      =0
coordinates =absolute
x          =0
y          =0
width      =101
height     =152
scalemode  =crop
```
The table below lists the meanings and possible values for custom print layouts.

<table>
<thead>
<tr>
<th>Print Setting</th>
<th>Value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td>&quot;image&quot; or &quot;caption&quot;</td>
<td>Specifies if this cell is an image or a caption</td>
</tr>
<tr>
<td>image</td>
<td>integer</td>
<td>Set this to a common integer to use data from one image in two cells. The Image and Caption cells for the same image should use the same value.</td>
</tr>
<tr>
<td>coordinates</td>
<td>&quot;absolute&quot; or &quot;percent&quot;</td>
<td>Specifies the coordinate system to use. &quot;absolute&quot; means x,y,width,height are in millimeters. &quot;percent&quot; means x,y,width,height are in tenths of percent (so a value of 250 means 25% of the page)</td>
</tr>
<tr>
<td>x</td>
<td>integer</td>
<td>Distance from the left edge of the page</td>
</tr>
<tr>
<td>y</td>
<td>integer</td>
<td>Distance from the top edge of the page</td>
</tr>
</tbody>
</table>
Color management is the technology and processes to match color across multiple image capture and reproduction devices. Proper color management ensures that colors are rendered on screen and in prints as faithfully as the various output technologies allow.

A color profile is a description of a specific color space. Color profiles can be stored in individual files (typically ending with .icm or .icc file extensions) or they can be embedded within an image file, like a JPEG or TIFF.
Every monitor, printer, or other image output device has unique color reproduction qualities. Printers color output also varies according to different ink and paper types. Every camera measures light and colors in a unique way. Having accurate color profiles for each device in your photographic workflow will ensure that you get the most accurate color and overall photographic quality from your digital photos.

Every image starts with an input profiles, which is converted into a working space, and then shown on screen in a monitor profiles. When the image saved out to a JPEG or TIFF, the image is saved in an output profile which is typically embedded within the resulting file. When printing, Corel AfterShot Pro can optionally convert the image to a printer profiles, ensuring color matching from on-screen to print.

**Input profiles**

Input profiles are used as the starting point for color management. Every image file in Corel AfterShot Pro has an input profile. For supported RAW files, Corel performs detailed color calibration and profiling techniques to produce unique Color Profiles for the various supported cameras. For TIFF and JPEG files, Corel AfterShot Pro will use the color profile embedded within the master file, if one exists. If no profile is found, JPEG files that begin with an underscore character are assumed to use the Adobe RGB color profile (as many cameras use this filename format when writing out Adobe RGB JPEG). Otherwise, the input profile is determined by the settings you choose in Preferences for TIFF and JPEG files.

Many digital cameras offer a choice of sRGB or Adobe RGB. This is meaningful only within the JPEG file written by the camera — this setting has no effect on image quality or color accuracy for RAW files in Corel AfterShot Pro.
Monitor profiles

Monitor profiles describe the display characteristics of your monitor. They are created with colorimeters which measure the light emitted from your monitor while displaying a known color pattern on the screen. Corel AfterShot Pro should automatically determine which monitor profile your Windows or Mac computer is using, but when you re-calibrate your monitor, it is good to verify that Corel AfterShot Pro correctly identified the new profile by looking at the Monitor Profile setting on the User Preferences panel.

Obtaining a Monitor Profile on Linux computers is more complicated, though it is possible. Corel AfterShot Pro cannot automatically determine the Monitor Profile used by Linux computers, so please set that manually on the User Preferences panel.

Printer profiles

Printer Profiles are ideally created by the photographer or print lab that owns and operates the printer. These are unique for printer, paper, and ink combinations. Many printer manufacturers include default profiles for their printers in combination with their paper and ink. Paper manufacturers also sometimes supply printer profiles for their paper.

Printer Profiles should be used whenever possible, and are added to individual Print Batches on the Print window.

Soft proofing

Soft proofing allows you to preview on your monitor what your image will look like once printed using a specific color profile that describes the printing characteristics of a specific printing process. Monitors and printers use very different technology to display images, and Soft Proofing will provide as accurate of a preview image as is technically possible. For Soft Proofing to work properly, you must be running Corel AfterShot Pro on a calibrated monitor with the proper monitor profile.
loaded into Corel AfterShot Pro, and you must select a color profile that has been created for your printer, paper and ink combination.

**Terminology**

These terms may be used by other applications, but have a specific meaning within Corel AfterShot Pro.

**Active version**

A single version that is being adjusted and is displayed in the Preview panel. If multiple versions are selected and visible in the Preview panel, then the active version will be the last one added. Simply click on any of the other previews to select that version and make it active.

Adjustment tools in the Tools panel show the settings for the active version only.

Keywords are the exception in the Tools panel — they can be applied to all selected versions, not just the active version.

**Catalog**

A catalog is a collection of photos and their associated image data. In essence, a catalog is a database that can be managed within Corel AfterShot Pro. Catalogs contain master files, thumbnails and preview images, image settings, image adjustments, and catalog-specific preferences.

**Library**

The Corel AfterShot Pro Library is where you store and access your catalogs.

**Master file**

A master file is a photo that you have opened in Corel AfterShot Pro. The master file is treated like a photo negative — it is protected from any direct changes. Master files can be RAW files, JPEG, or TIFF. All master files are edited and managed non-destructively.

**Master version**
A master version is the preview generated for the master file in Corel AfterShot Pro. It is an editable preview that corresponds to master file (protected) + edits (saved to XMP file and possibly a catalog file). If you delete/remove a master version in Corel AfterShot Pro, the master file and all related versions are moved to the Recycle Bin.

**Stack**

A group of images that are similar in content or subject matter that can be "rolled up" to show a single image representing the whole group, or "expanded" to show all the images in the stack.

**Version**

When making image adjustments in Corel AfterShot Pro, you are editing versions instead of altering the master file. The initial thumbnail is called the master version. You can have many versions from the same master file; for example a color, sepia, and Black & White version — all based on the same master file.

**General Digital Photographic Terminology**

These are terms that are common to digital photography, and are included here as a convenience. For more information on Digital Photography, or photography in general, a great place to start is Wikipedia:


**Luma**

Luma or Luminosity is a measure of the brightness of an image or pixel. This is typically calculated as $0.2126 R + 0.7152 G + 0.0722 B$. Luma is also called Value in the HSV (Hue Saturation Value) color model.

**Chroma**
A measure of the color of an image or a pixel, sometimes called Hue, as in the HSV color model.

**Asset management**

Asset management involves importing your photos to create photo databases (called catalogs) that manage the data related to your photos. The databases make it easy find and track your photos based on photo data, such as EXIF info or ratings and keywords that you assign. Asset management also involves archival tasks, such as creating backups or exporting databases.

**Metadata**

Metadata, in a photographic context, refers to all the information related to a photo. It can include data that comes from your camera settings, such as shutter speed, aperture, and ISO. It also includes EXIF data, such as time and date the photo was taken. You can also add metadata, such as keywords, ratings, and captions.

**JPEG files**

JPEG (Joint Photographic Experts Group) is the most widely used digital image file format, ideal for sharing photographs on the web, in email, or as final-product images. JPEG files are compressed using Lossy Compression, and thus do not contain as much data as RAW or other lossless file formats.

**TIFF files**

TIFF (Tagged Image File Format) is a file format for digital images that provide the highest quality output image from Corel AfterShot Pro. TIFF is a broadly supported file format that saves all the detail and color information in your photographs without using lossy compression (unlike JPEG images). TIFF images are quite a bit larger in file size than a comparable JPEG image.

**RAW files**

Often called "digital negatives", RAW files are digital photo files that capture relatively unprocessed (thus "raw") data from the digital camera's sensor. The files tend to be larger than other file formats because they capture a wide range of image data. The data gives you
more precise image adjustment results and more post-processing options. After you adjust the files, they must be "developed" by outputting them to a standard file format, such as JPEG. Different camera models produce different RAW files formats (for example, many Canon cameras produce CR2 files and most Nikon cameras produce NEF files).

**Workflow**

A workflow, in the context of digital photography, refers to the process that occurs between the time you capture a digital photo and the time you output the photo to its final destination and format. This includes everything from getting your images off your camera and into your computer, adding keywords and other metadata, editing and optimizing your images, managing backups and archives, printing, outputting to the Web, as well as many other steps and processes.

Your workflow might be simple and ad-hoc, or it may be complex, codified, and very repeatable and structured.

**IPTC**

An industry-standard set of metadata used to label and categorize digital photos. It was created by the International Press Telecommunications Council and used by many photographic agencies and applications.

**XMP / IPTC**

This is a newer standard that includes many improvements.

**Sidecar files**

A sidecar file is any file that is associated with an image file and is found in the same folder as the image file. These typically include:

- XMP files — store settings and metadata for an image file
- WAV files — voice notes or other audio recordings associated with an image

Some RAW files store thumbnails in separate sidecar files.

**Color management**
The technology and processes to match color across multiple image capture and reproduction devices. Proper color management ensures that colors are rendered on screen and in prints as faithfully as the various output technologies allow.

Every monitor, printer or other image output device has unique color reproduction qualities. Printers vary these qualities with different ink and paper brands and types. Having accurate Color Profiles for each device in your photographic workflow will ensure that you get the most accurate color and overall photographic quality from your digital photographs.
Updating and extending the application

You can extend and update content and components of Corel AfterShot Pro by using the Get More page in the Tools panel. With a combination of free and paid content, as well as content management features, the dynamic Get More page offers an easy way to tap into new plugins, camera profiles, image presets, and more.

In this section, you’ll learn about
• Finding and installing downloadable content
• Providing feedback for downloadable content
• Restoring purchases

Finding and installing downloadable content

You can find and install downloadable content for AfterShot Pro by using the Get More page.

To open the Get More page
• In the Tools panel, click the Get More tab.
The Get More page opens. Each section offers different types of content. Some types of content include descriptions that can be accessed by clicking content.

**To install content from the Get More page**

1. On the Get More page, open the section you want (such as the Plugin Manager).
2. To the right of the content that you want to install, click the download button.
   
   By default, the download buttons display Install, Free, or a price.
3. Follow any instructions for downloading or purchasing the content.
   
   The content is installed. You might need to restart your application to activate some types of content.

**Providing feedback for downloadable content**

We’d like to hear your feedback about any issues or success that you experience with the content that you install.

**To provide feedback for downloadable content**

1. Click the Get More tab on the Tools panel.
2. Open the section for which you want to provide feedback.
3. Click the Feedback button at the bottom of the section.
4. Fill in the feedback form.

**Restoring purchases**

If you need to rebuild your computer system or if you buy a new computer, you can restore any content or extensions that you have installed from the Get More page.
To restore purchases
1. Click the Get More tab on the Tools panel.
2. Open the section for which you want to restore purchases.
3. Click the Restore Purchases button at the bottom of the section and follow any instructions that appear.
Legal notice
Corel® AfterShot™ Pro 3 User Guide

Copyright 2016 Corel Corporation. All rights reserved. Product specifications, pricing, packaging, technical support and information ("specifications") refer to the retail English version only. The specifications for all other versions (including other language versions) may vary.

INFORMATION IS PROVIDED BY COREL ON AN "AS IS" BASIS, WITHOUT ANY OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY, SATISFACTORY QUALITY, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR THOSE ARISING BY LAW, STATUTE, USAGE OF TRADE, COURSE OF DEALING OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS OF THE INFORMATION PROVIDED OR ITS USE IS ASSUMED BY YOU. COREL SHALL HAVE NO LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOST OR DAMAGED DATA OR OTHER COMMERCIAL OR ECONOMIC LOSS, EVEN IF COREL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. COREL IS ALSO NOT LIABLE FOR ANY CLAIMS MADE BY ANY THIRD PARTY. COREL'S MAXIMUM AGGREGATE LIABILITY TO YOU SHALL NOT EXCEED THE COSTS PAID BY YOU TO PURCHASE THE MATERIALS. SOME STATES/COUNTRIES DO NOT ALLOW EXCLUSIONS OR LIMITATIONS OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

© 2016 Corel Corporation. All rights reserved. Corel, AfterShot, the Corel logo, and the Corel Balloon logo, and PaintShop are trademarks or registered trademarks of Corel Corporation and/or its subsidiaries. All other product names and any registered and unregistered trademarks mentioned are used for identification purposes only and remain the exclusive property of their respective owners.